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WARNING
VSPM-6F2113 (Inspector PIM60), VSPM-6B2113 (Inspector PIM60 Base), VSPM-6F2113S19 (Inspector PIM60
Bead)

The Inspector is equipped with a LED illumination
that must be considered as a lamp system of Risk
Group 1 (low risk) according to IEC 62471:2006
Accessible irradiance at distances > 200 mm:
LB <4 x 104 W/(m2 sr) within 100 s
LH <106 W/(m2 sr) within 10 s

WARNING: OPTICAL RADIATION DO NOT STARE INTO BEAM
RISK GROUP 1 (LOW RISK) according to IEC 62471:2006

Visible LED light λ = 400-800 nm

VSPM-6F2313 (Inspector PIM60-LUT), VSPM-6F2313S20 (Inspector PIM60-LUT Bead)

The Inspector is equipped with a LED illumination
that must be considered as a lamp system of Risk
Group 1 (low risk) according to IEC 62471:2006
Accessible irradiance at distances > 200 mm:
ES < 3 x 10-3 W/m2 within 104 s
EUVA < 33 W/m2 within 300 s
LR < 7 x 106 W/(m2 sr) within 10 s

WARNING: OPTICAL RADIATION DO NOT STARE INTO BEAM
RISK GROUP 1 (LOW RISK) according to IEC 62471:2006

UV LED light λ = 385 nm

VSPM-6F2413 (Inspector PIM60-IR), VSPM-6B2413 (Inspector PIM60-IR Base), VSPM-6F2413S18 (Inspector
PIM60-IR Bead)

The Inspector is equipped with an LED illumin-
ation that must be considered as a lamp system
of Risk Group 0 / Free Group (exempt risk) ac-
cording to IEC 62471:2006
Accessible irradiance at distances > 200 mm:
EIR < 100 W/m2 within 103 s
LIR < 1.2 x 106 W/(m2 sr) within 103 s

NOTICE: IR EMITTED FROM THIS PRODUCT
RISK GROUP 0 (EXEMPT RISK) according to IEC 62471:2006

IR LED light λ = 850 nm

DISCLAIMER
SICK uses standard IP technology for its products, e.g. IO Link, industrial PCs. The focus here is on providing avail-
ability of products and services. SICK always assumes that the integrity and confidentiality of data and rights involved
in the use of the above-mentioned products are ensured by customers themselves. In all cases, the appropriate
security measures, e.g. network separation, firewalls, antivirus protection, patch management, etc., are always im-
plemented by customers themselves, according to the situation.
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Introduction



1 Overview

Inspector PIM60 is a cross functional variant
within the Inspector Vision Sensor family. It is
designed to solve inspection, positioning and
measurements tasks to improve quality and
efficiency in part production and logistic
handling.
Inspector PIM60 is easily configured through
the SOPAS Engineering Tool (ET) to analyze ob-
jects and to communicate inspection results
over different interfaces.
After finished configuration, PIM60 is running
stand alone and continuously reporting the
result over the configured interface.

The main features of Inspector PIM60 are:

Device features
• High-speed inspection, positioning and measurement
• Toolbox for inspection of blobs, patterns, edges, circles, edge counting, and pixel counting
• Toolbox for positioning taught-in, free-form and model shaped objects
• Tool box for measurement of diameters, angles and distances
• Import/Export of configurations
• Image and result calibration, and position alignment
• Ethernet communication through EtherNet/IP and Ethernet Raw
• HMI integration via Web API, including import of customized web pages
• Web access using HTTP
• Exchangeable lens
• Outputs by logical expressions
• Digital input and output extensions via external I/O box (accessory)
• Store inspected images to remote FTP server

SOPAS Engineering tool (ET) PC software
• Single device configuration
• Project handling of multiple devices
• Import/export of configurations
• Image log and statistics view
• Simulated device environment for off-line configuration

1.1 Safety
• Read the operating instructions before using the Inspector.
• Assembly, connection, and configuration must be performed by competent technicians.
• Do not connect external I/O signals to the Inspector while it is powered. This may damage

the device.
• Make sure that any loose cable ends are properly separated or isolated before powering

the Inspector. Otherwise the device may be damaged.
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• Protect the Inspector from moisture and dirt during operation.
• Do not use the Inspector in areas with risk for explosion.
• To keep IP 67 classification, open and close the front window only with the supplied tool.

Make sure that the seal fits properly.
• To avoid damage, use only SICK lens accessories with correct distance rings.
• Minimize the risk of getting dust into the device by changing the lenses in a dust-free en-

vironment. Do not keep the device without the front window and wipe off the device and
front window before you open it.

• For safe and proper use; if the lens and/or front window are to be replaced, make sure
that the new lens and front window accessory are assembled correctly.
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2 Applications
There is a broad toolbox available in the Inspector PIM60 and the concept allows for high
flexibility in combining all the tools within an application configuration. This section describes
a number of examples for solving positioning, inspection and measurement tasks with the
toolbox.

2.1 Verify dimensions and locate position of a known shaped ob-
ject

In this example the Inspector is used to inspect the front window tool supplied with the in-
spector.
The tasks of the Inspector are to:
• Measure the distance between the pins used for exchanging the window (on the wide end

of the tool).
• Measure the width of the tool.
• Measure the inner distance between the pins used for exchanging the lens (narrow end

of the tool).
• Get the position of the center of the hole, to use for guidance.
Solution:
1. An Object locator is used to locate the object in the image, in case it moves around in

the field of view (FOV).
2. Blob tools are used to finding the centers of the pins for exchanging the window. A dis-

tance tool is used for measuring the distance between the reference points.
3. Edge tools are used for determining the positions of the left and right edges of the front

window key, and a distance tool is used for measuring the width.
4. Pattern tools are used for locating the pins used for exchanging the lens. The reference

point that the pattern tool reports the position of can be moved manually, and in this
example they have been placed on the top of the inner side of each pin. A distance tool
is then used for measuring the distance between the two reference points.

5. A circle tool is used for finding the position of the center of the hole.

Figure 2.1 Inspector PIM60 verifies the center-to-center distance between the window
grippers, the gap of the lens gripper, and the position of the center of the hole.
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2.2 Measure distance and angle
In this example a battery lid of a mobile phone is used. The tasks of the Inspector are to:
• Measure the size of the gap between the rear lid edge and the locking hook.
• Measure the angle between the lid edge and the locking hook.
Solution:
1. An object locator is used to locate the object in the image, in case it moves around in

the FOV.
2. Edge tools are used to locate the edge of the lid and the inner edge of the locking hook.

A distance tool is used to measure the size of the gap.
3. An angle tool is used with the two edges to measure the angle between them.

Figure 2.2 Inspector PIM60 locates the object, and measures the size of the gap and the
angle of the locking hook.

2.3 Lid integrity verification
In this example a plastic cap for a milk package is used. The tasks of the Inspector are to:
• Measure the diameter of the innermost ring and the outer cap diameter.
• Measure the concentricity between the inner and outer circle.
• Verify that there are prints on the cap.
Solution:
1. An object locator is used to locate the object in the image, in case it moves around in

the FOV.
2. Two circle tools are used - one for locating and measuring the diameter of the innermost

ring, and another for the outermost circle.
3. A distance tool is used to measure the distance between the centers of the located

circles, which can be used as a measurement of the concentricity.
4. An edge pixel counter tool is placed on the interior of the cap, to detect that there is print

on the cap.
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Figure 2.3 Inspector PIM60 locates the lid, measures the diameter and concentricity,
and verifies that there is printing on the cap.
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3 Configuration and machine integration
The Inspector PIM60 is designed for machine integration and offers a number of interfaces
to interact with control equipment. The feature scope of machine integration is result, mon-
itoring, and control. The following image shows a summary of the available interfaces.

12

Photoelectric switchConfiguration and operator interfaces
I/O extension box Switch for external teach

External lightingEthernet field bus for result and control
Customized HMI interfaces Power supply

Output signals (1..3)File transfer protocols
12Encoder External object selection

(1..4)

Figure 3.1 Possible interfaces in a configuration setup.

3.1 Initial configuration
The initial tool configuration and interface configuration of Inspector PIM60 is managed with
SOPAS Engineering Tool (ET) . This is a PC application free to download from www.sick.com,
which can be used for monitoring and advanced supervision apart from the initial configuration.
After the initial configuration, the Inspector PIM60 is ready to interact without connection to
SOPAS Engineering Tool (ET) according to its set-up.

3.2 Result and image retrieval
The Inspector PIM60 generates the result after each image acquisition. This result can be
read out over the different interfaces; for example as a binary value on the digital outputs or
as detailed values over the field buses. Images can also be retrieved over some of the inter-
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faces, for view or storage. The following table shows what type of results and images that
are available on the different interfaces.

Available resultsInterface

Pass/failBinary outputs a

ValuesPass/failFieldbus b

Current imageBuilt-in web server
Image log

Current imageStatisticsValuesPass/failCustom HMI c

Image log

Image logFile transfer protocol d

Current imageStatisticsValuesPass/failSOPAS Engineering
Tool (ET) Image log

a3 built-in outputs. Up to 16 outputs with External I/O box.
bEthernet raw, EtherNet/IP.
cUsing Web API.
dStoring on FTP server.

3.3 Configuration and control
The Inspector PIM60 supports external configuration handling and control. Once a configur-
ation is created in SOPAS Engineering Tool (ET) it can be stored directly on the device or
exported to external memory for later handling such as device cloning or field exchange.
The Inspector PIM60 can be controlled over the digital inputs as well as over the Ethernet
interfaces. The digital inputs offers device control while the Ethernet interfaces also support
update of the configuration. The following table shows the possibilities of configuration and
control via the various interfaces.

Interface

Teach/re-
teach object

Switch ref
object

Image trig-
ger

Binary in-
puts a

Encoder

Change
most para-
meters

Calibrate
and align
device

Teach/re-
teach object

Switch ref
object

Image trig-
ger

Fieldbus b

Load and re-
trieve config-
uration

Switch ref
object

Built-in web
server

Change
most para-
meters

Load and re-
trieve config-
uration

Calibrate
and align
device

Teach/re-
teach object

Switch ref
object

Image trig-
ger

Custom
HMI c

Create new
configura-
tion

Load and re-
trieve config-
uration

Calibrate
and align
device

Teach/re-
teach object

Switch ref
object

SOPAS En-
gineering
Tool (ET)

Change all
parameters

a4 built-in inputs. Up to 5 additional inputs for switching reference object with External I/O box.
bEthernet raw, EtherNet/IP.
cUsing Web API.
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3.4 Connections

Power I/O

FTP serverWeb browserEthernet field-
buses

I/O extension
box

PC with
SOPAS

Figure 3.2 Connections Inspector PIM60
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4 Toolbox
The Inspector’s toolbox for image analysis includes the following types of tools:
Positioning tools Used for locating objects of different shapes, or features such as

edges and circles, in the images.
Inspection tools Used for inspecting areas on located objects, or fixed areas in the

images.
Measurement tools Used for measuring distances and angles between located objects

or features.
Of the positioning tools, the Object locator is unique since other tools can be applied relative
to the object that is found. This makes it possible to inspect and measure on an object without
knowing exactly where in the image it is positioned.
Therefore, a typical image analysis configuration usually consists of one Object locator that
locates the object in the image, followed by a number of other tools that inspects details on
the object or locates features to measure between.

Object locator finds the taught
shape in the image.

Measurement between found fea-
tures on the object.

Inspection and other positioning
tools are applied relative to the
found object.

The result from the image analysis can be one or more pass/fail results, based on thresholds
set for certain values from the tools, and detailed result values, such as positions of features,
counted pixels, or measured distances.
Each reference object in the Inspector PIM60 can contain one Object locator and up to 64
other tools. Up to 8 of these tools can be Blob tools, up to 8 Polygon tools, and up to 4 Edge
counter tools.
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Positioning tools

Object locator
Locate pre-taught object independent of position, scale and rotation variations.
Use when the shape of the object is always the same.
One Object locator region can be applied per reference object.
Results: Match score.

Position, angle and scale values.

Circle
Locate a circular edge within a region and fit a circle to that edge.
Results: Match score

Position and diameter of the located circle.

Edge tools (Edge)
Locate a straight edge within a region and fit a line to that edge.
Results: Match score.

Position and rotation of the located edge.

Edge tools (Find maximum)
Locate the first or last edge point along the search direction of an inspection region.
Results: Position of the located point.

Edge counter (Linear)
Count the number of edges along a straight path, and measure the distance between
the edges (pitch).
Results: Number of edges. Mean, maximum and minimum pitch.

For each edge: Position, angle, polarity, width, and internal angle.

Edge counter (Circular)
Count the number of edges along a circular path, and measure the angle between the
edges (pitch).
Results: Number of edges. Mean, maximum and minimum pitch.

For each edge: Position, angle, polarity, width, and internal angle.

Blob
Find clusters of pixels, blobs, within a defined gray range and size of cluster.
Results: Number of found blobs.

For each blob: Size, position, rotation, number of interior edge pixels, and
border status.

Pattern
Compare a gray scale pattern pixel by pixel within a region.
Results: Match score, position.

Polygon
Find edges of a pre-defined number of sided polygon (open or closed).
Detect defects on edges inside a closed polygon.
Results: Position of the end points and intersection of edges.

Edge defect score.
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Inspection tools

Pixel counter
Count pixels of a certain gray range within a region independent of pattern or clustering.
Results: Number of pixels.

Edge pixel counter
Count edge pixels within a region independent of pattern or clustering.
Results: Number of edge pixels.

Bead tool
Verify completeness, position and width tolerance of string-formed features, for example
glue beads.
Results: Pass/fail

Measurement tools

Distance
Measure the distance between located objects and features, such as edges, circles,
or patterns.
Results: Measured distance in pixels or millimeters.

Angle
Measure the angle between located edges.
Results: Measured angle in degrees.

Position of intersection.
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How To



5 Getting started
This chapter will guide you through the setup steps of locating and inspecting an object using
some of the tools in the toolbox.

5.1 Preparations
In this example, we will use the tool used for exchanging the front window and lens, that is
supplied with the Inspector. We want to get the position of the tool for picking, and verify the
position of the small hole on the tool.
We will verify the position of the hole by measuring the distance between the hole's center
and the bottom edge of the tool, and set thresholds on the allowed values. To do this we first
need to locate both the edge and the hole, and after this we can define the measurement.

Figure 5.1 Front window key.

5.1.1 Open the box
The Inspector PIM60 is delivered with the following parts:
• Inspector PIM60 device
• Printed Quick Start instructions
• A hex key for adjusting focus
• Tool for removing the front window and changing the lens
For this application example, you will need the Inspector PIM60, the Hex key for adjusting
the focus, and the front window key as the object to inspect.

5.1.2 Install SOPAS
SOPAS Engineering Tool (ET) is the PC application for Windows used to configure devices
in the Inspector Vision Sensor Family.

Install from sick.com
To install the application:
1. Start your computer and connect to the internet. Go to www.sick.com and search for SOPAS

Engineering Tool (ET).
2. Download latest version of SOPAS Engineering Tool (ET).
3. Run the installer.
4. Follow the on-screen instructions to complete the installation. A full installation is recom-

mended.
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5.2 Connect

5.2.1 Connect the hardware
1. Mount the Inspector so that it is facing the object.

Figure 5.2 Mount the Inspector facing the object.

2. Connect the Ethernet cable between the Inspector and the PC.

Figure 5.3 Connect the Ethernet cable.

3. Connect the Inspector power I/O cable to a 24 V DC power supply:
Brown +24 V DC, pin 1
Blue Ground (GND), pin 2

Figure 5.4 Connect to 24V DC power supply.

5.2.2 Connect SOPAS to the Inspector
1. Start SOPAS Engineering Tool (ET) application on the PC.
2. Connect to the device. See Chapter 6 "Connect".
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5.3 Get a good image

Figure 5.5 Main view and image settings tab.

When the device is connected the live image is shown in the Main view.
1. Click Edit to switch from Run to Edit mode.
2. Place the object under the view of the Inspector so that it is visible in the Live image tab.
3. In the Image settings tab, click Auto to automatically adjust the image exposure and gain

values.

Too brightGood imageToo dark

Figure 5.6 Image quality by tuning exposure time.

4. Adjust the focus by turning the adjustment screw on the top of the Inspector using the
included 2 mm hex key.

Figure 5.7 Adjusting focus.

The Image settings tab displays a focus feedback bar, which indicates when the focus is
optimal.
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Figure 5.8 Focus feedback bar.

The image should now be sharp and neither too bright nor too dark.

5.3.1 Calibrate the Inspector (optional)
When the focus and exposure is configured, the live image can be calibrated. Calibration of
the Inspector is an optional step that can be performed to get a good image in case of distorted
image due to tilted mechanical set-up or use of a wide angled lens.
To be able to present values and positions in millimeter, as a unit of measurement instead
of pixels, a calibration must be performed.
In addition to calibration, the Inspector can be aligned with an external coordinate system,
for example to present positions in a robot's coordinate system.
See Chapter 9, “Calibrate and align” (page 40) for information on how to perform calibration
and alignment. After the calibration, a reference image can be taken.

5.4 Configure the application
Configuration of the application involves teaching a reference image, and applying tools and
result settings to that reference image. The image will be added to the "reference objects"
and is used as a reference when analyzing acquired images in runtime.

5.4.1 Teach the reference object
With the object in focus in the Live image tab, teach the reference object by clicking the Teach
reference object.

Figure 5.9 Teach reference object button.

A reference image will be created in the Reference objects list.
When the new reference object has been created, apply the desired tools in the Reference
image tab.

Note
It is possible to replace the image for a reference object. Click on the reference object in the
Reference objects list and choose Live image tab and click Replace reference image.

5.4.2 Apply tools
Different tools within the toolbox are used to solve the application to position and inspect
the front window key:
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Figure 5.10 Applying tools in the reference image

Add Object locator
The Object locator is used for retrieving the location of the object in terms of position and
rotation. The location is used for two things: for positioning the additional tools, and for re-
porting the coordinates for precise picking.
To add an object locator:
1. Click on the Object locator button in the toolbox below the image.
2. With the Object locator tool, draw a rectangle over the front window tool in the image,

or a part of it.
The blue rectangular region – the object locator region – marks which part of the image to
be taught. The green contours inside the region show what shape is recognized by the Inspect-
or.
For the object locator to work well, there must be a sufficient amount of green contours in
the region. The amount of contours is adjusted with the Edge contrast slider in the Tools tab.
The Mask tool can be used to mask out areas in an image with noise to obtain a better result.
For example noise caused by a rough surface area, or a label on the object..

Bad, too few contours.Good, sufficient amount of
contours.

Bad, too much noise in the
image mistaken as contours.

Figure 5.11 Adjusting the amount of contours.
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In the center of the blue object locator region is a purple cross marking the reference point,
which is also the position that the Inspector report. If a particular point on the object shall
be reported rather than the center of region, for example as a pick point for a robot, move it
manually to the appropriate position.

Add an Edge tool
An Edge tool is used for finding the edge that we are going to measure from. To add the Edge
tool:
1. Click on the Edge tools button in the toolbox below the image and select Edge.
2. With the Edge tool, draw a rectangle over a part of the bottom edge of the front window

key.
A green line in the edge tool region shows where the Inspector found an edge, and the thin
yellow arrows shows in which direction the Inspector searches for edges. If the incorrect edge
is indicated, or if the line is red, adjust the settings so that the right edge is located:
• Rotate the region so that it is somewhat parallel with the edge. In order to locate an edge,

the edge must enter/exit the region through the region sides that are parallel with the
search direction.

• Decrease the Edge contrast setting (move to the left) if the contrast between the bright and
the dark side of the edge is low.

• Adjust the settings for Criteria and Polarity to make the Inspector pick the right edge if there
are multiple edges in the region.

Figure 5.12 Settings for the Edge tool.

Add a Circle tool
A Circle tool is used for finding the small hole. To add the Circle tool:
1. Click on the Circle button in the toolbox below the image.
2. With the Circle tool, add a circle region around the hole on the front window key.
A green circle in the circle tool's region shows where the Inspector found the circle, a purple
cross marks the center of the located circle, and the yellow circles indicates the max and
min diameter that the inspector will look for. If an incorrect circle is found, or if the circle is
red, adjust the settings so that the correct circle is located:
• Make sure that the inner yellow circle is entirely inside the hole, adjust by moving the circle

region.
• Decrease the Edge contrast setting (move the slider to the left) if the contrast between the

hole and the rest of the front window key is low.
• Adjust the settings for Circle fit criteria and Polarity to make the Inspector pick the correct

circle if there are multiple circles in the region.
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Figure 5.13 Settings for the Circle tool.

Add Distance measurement
Now that the Inspector locates the bottom edge and the hole on the front window key, we
can measure the distance between them. To add the Distance tool:
1. Click on the Distance button in the toolbox below the image.
The features that you can measure between are now marked with white circles.
2. Click on the white circle marking the Edge tool, and then on the white circle marking the

Circle tool.
The measurement is now shown as a green line between the edge and the hole.
By default new measurements will be made between the reference points on the located
features. However, in this case it is better to measure the distance perpendicularly to the
located bottom edge.
3. In the Tools tab, set the Type of the Distance measurement to Right angle.
4. If necessary, adjust the tolerance for the distance.

Figure 5.14 Settings for the Distance tool.

Tool relation
By default, all tools will automatically be positioned relative to where the object locator finds
the object, which makes the inspections follow the position and rotation of the front window
key as it is moved around in front of the Inspector.

Figure 5.15 Tool relation
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5.4.3 Monitor the result
Switch from the Reference image tab to the Live image tab to see how the Inspector locates the
object as it is moved around, and also how it reports the results of the inspection in the Results
tab.
The Results tab shows the overall result and state of the digital outputs. More information on
what results are displayed in the Results tab is found in Chapter 11, “View result and statist-
ics” (page 75).

Figure 5.16 Live image and result when hole is missing.

In addition, detailed results such as match score (the green bar) and the location of the ref-
erence point is displayed.

5.4.4 Using the result
For positioning applications, this result can be retrieved from the Inspector via Ethernet. Note
that the x and y coordinates are the number of pixels from the top left corner of the image.1

Note
The digital outputs are enabled by default for the Inspector PIM60, but they are turned off
when the Inspector is in Edit mode.
If you want to use the digital outputs even in Edit mode, you can enable them by choosing
Interfaceand I/OSettings from the InspectorPIM60menu, and then selecting Enablebuilt-in outputs
in Edit mode on the Digital I/O tab in the dialog box.

1To be able to present values and positions in millimeter, as a unit of measurement instead of pixels, a calibration
must be performed. See Chapter 9, “Calibrate and align” (page 40) for more information.
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6 Connect

Note
At the first use, the PIM60 will require a SOPAS Device Driver (SDD). When adding the device,
a prompt will appear with instructions on how to install the driver. When prompted for SDD
installation source, select From sick.com.

The main SOPAS Engineering Tool (ET) window is split into two panes, the project view to the
left and a list of available devices to the right. Click Add to add the PIM60 to the project view.
Double click the device icon to connect to the device and access the device main window.

6.1 Manage IP address
Click the Edit icon in the device tile to make adjustments to IP settings.

6.1.1 Troubleshooting connection problems

No device was found
• Make sure the Inspector has started.

You may have to wait up to 40 seconds after switching on the power or after restarting the
Inspector before it's available for connection.

• Make sure the PC has a network connection.
The icons in the Windows taskbar can indicate if the PC's network connection is not
working properly:

Win 7XP

The PC has no connection to the network

The PC is trying to connect to the network, but does not yet have a network
connection.

The PC is connected to a network, but the connection is not properly set up.
This should be OK if the Inspector is connected directly to the PC without any
local network.

• Click Scan again to make SOPAS search the network again.

Ethernet connector icon is red

Notice: "Please configure the device interface"
You will need to change the IP address of the Inspector or the PC before connecting.
To change the Inspector's IP address, do the following:
1. Select the Inspector in the list of found devices.
2. Depending on the connection to the Inspector, do one of the following:

If the Inspector is connected with the Ethernet cable directly to the PC, choose to
change the device IP settings Automatically. When the new settings are presented, click
Yes to write the settings to the Inspector.

•

• If the Inspector is connected via a local network, that has a DHCP server available that
distributes IP addresses. In that case choose to change the device IP settingsManually,
select Obtain the IP settings automatically (DHCP) and click OK.

Other connection problems
See the SOPASEngineering Tool help for more information on other connection related problems.
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6.2 Install a SOPAS Device Driver (SDD)
The Device Catalog allows you to manage SOPAS Device Drivers (SDD). The Device Catalog can
be accessed by choosing New from the Project menu in SOPAS Engineering Tool (ET).

Note
The Inspector PIM60 has two available SDDs; Inspector PIM60 V1.0.0 and Inspector PIM60
V2.0.0. The Inspector PIM60 Bead has a separate SDD. These versions can co-exist.

The following installation functions are available in the Device Catalog window:
Uninstall Uninstalls a SDD. The selected SDD is removed from the Device Catalog.
Install Installs a SDD. An Installation Wizard provides the following installation op-

tions:
From sick.com - This option will install SDD files from the SICK website. Make
sure to select the correct model of your device to install the correct SDD files.
From file - This option will install the selected SDD and help files (excluding
the online help files). Incompatible SDD files are printed orange but will be
installed. Already installed SDD files are marked with a STOP sign and will not
be installed.

Update Updates an SDD.

6.3 Upgrade or downgrade the firmware
It is possible to upgrade, and downgrade, the Inspector's firmware using a separately distrib-
uted PC application called Inspector Download Manager. Contact SICK Technical support,
see Section B.1, “Technical support” (page 130), for information on how to obtain a copy of
the Inspector Download Manager and the firmware installation file.

Warning
It is not possible to run a configuration, .sdv or .spb, made using Inspector PIM60 V 1.0
firmware on an Inspector PIM60 with V 2.0 firmware (or vice versa). The present configuration
needs to be redone.
If it is not an option to redo the configuration, it is possible to downgrade from PIM60 V2.0
firmware to PIM60 V1.0 firmware.

6.4 Use a simulated device
How to use a simulated Inspector device instead of connecting to a real Inspector is described
in Chapter 23, “Use the simulated device” (page 118).
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7 Use SOPAS Engineering Tool (ET)
The main usage of the PC based configuration application is to configure the Inspector. It
also features a powerful support for monitoring live or log images, results and statistics in
runtime. It also has support for post analysis and fine tuning of configuration in a simulated
device environment.

7.1 Framework
This section describes the framework when connected to a real device. For specific controls
for the simulated device, see Chapter 23, “Use the simulated device” (page 118). The figure
below describes the SOPAS Engineering Tool (ET) application and Live Image tab in the
Main view after connected to the device.

Figure 7.1 SOPAS Engineering Tool (ET) device main window

Menu bar:
Devicemenu with for example alternatives for opening, and saving device configuration•

• InspectorPIM60 menu, see Section 7.3, “InspectorPIM60 menu” (page 34)
• Parameter menu with the possibility to for example to load data to the device
• View menu. Select visible views in the GUI.
• Help menu for starting Help and view version information About Inspector (application,

FPGA, and monitor firmware versions)
Toolbar
Main view with information and controls for (see Section 7.2, “Main view” (page 33)):

Image view that can be either of Live image, Reference image, Logged images.•
• Reference objects list
• Teach reference object.
Tabs for different detailed configuration tasks for Inspector PIM60
Status bar reporting the user level, connected device, and synchronization status
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7.2 Main view

Run/Edit switch
Click Edit to teach reference images, set up inspections, and to test. Click Run mode for oper-
ating the device at full speed in production conditions. Settings can not be changed in Run
mode.

List of Reference objects
The Referenceobjects list contains all taught reference objects. To select which reference object
to work with, select Edit mode and click on the reference object in the list. Click the Add button
to create a new reference object. Click the Delete button to remove the selected reference
object.
Right-clicking a reference object opens a context menu which provides the following additional
functions: Copy to new reference object, Remove object, and Rename object.

View controls
The view control buttons consists of tools to work with regions and to set the view of the image.
The buttons are:

Select regions. When moving the mouse pointer over the image the coordinates are
visible in the frame of the image.

Move (pan), move a zoomed in image

Zoom in the reference image

Zoom out in the reference image

Zoom to fit - restores the image to full size after zooming in or out

Show or hide contours and feedback graphics of a ROI of a tool or locator in the refer-
ence image

Frame rate and minimum delay time
Frame rate shows the number of analyzed images per second (in Hertz, Hz). For triggered in-
spections, the max frame rate is the highest frequency with which the trig pulses can occur.
Trigger pulses that occur at a higher rate are discarded, and can be viewed in the Statistics
tab as Number of ignored trigger pulses. The Minimum delay time is the shortest delay time on any
output signal (in milliseconds, ms). See also Chapter 21, “Improve speed” (page 114).

7.2.1 Live image tab

Live Image
The Live image tab contains view control buttons, a teach button, and a button for turning the
graphical overlay on or off. When clicking on the teach buttons, an image is captured. An
Object locator or desired tool can now be used in the new reference image.

7.2.2 Reference image tab
In the Reference image tab you can find the tools to use in the reference object.
All tool regions - except for Polygon and measurement tools - in a reference object can be
copied and pasted by right-clicking on the region. An object locator can only be copied from
one reference object to another, since a reference object can have only one object locator.
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7.2.3 Logged images tab
The Logged images tab lists the latest logged images. The images is shown in the images
list in the lower part of the tab. Choose which images to log by choosing from Log settings
from the InspectorPIM60 menu. When the Inspector PIM60 is storing images to FTP, the
image log cannot be displayed.
The list of logged images contains the 30 most recent logged images. To delete all images
in the log, click on the Clear log button. To refresh the list, click on the Update log button.
To save the images in the log to file, click on the Save log button. The images will be saved
in two separate folders, one folder with the saved images with graphical overlay and one
folder without graphical overlay in the saved images.

7.3 InspectorPIM60 menu

Run
The menu item is shown when SOPAS Engineering Tool (ET) is in Edit mode. To switch the
Inspector to Run mode:
1. Choose Run from the InspectorPIM60 menu.

A warning dialog box is displayed if any settings have been changed.

2. Click Save to flash to save the new settings in the Inspector's flash memory (permanent
storage of configuration on device).

Edit
The menu item is shown when SOPAS Engineering Tool (ET) is in Run mode. To switch the
Inspector to Edit mode, choose Edit from the InspectorPIM60 menu.

Record Live Images
Saves a stream of live images to file on the disk drive of the PC. For a detailed description
see Section 22.3, “Record live images to PC” (page 117).

Interfaces and I/O Settings
To view or change interface settings, choose Interfaces and I/O settings from the InspectorPIM60
menu. Note that the settings made here are global for all reference objects. For more inform-
ation about to configure the interfaces, see Chapter 14, “Use digital I/O” (page 83) to
Chapter 17, “Use web interface” (page 97).

Digital Output Expression Editor
In the dialog Digital Output Expression Editor you can define additional inspection results
– for example if certain detailed inspections failed – which can then be mapped to digital
outputs. For more information about digital output expression editor see Section 14.3, “Use
digital outputs” (page 87).
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Ethernet Result Output
To configure the device to send Ethernet based result output, choose Ethernet Result Output
from the InspectorPIM60 menu. For more information, see Section 16.2, “Output res-
ults” (page 94).

Device Info
To see information about the current device, choose Device Info from the InspectorPIM60 menu.
The Device Info dialog box is displayed, with two different tabs: General and Network.
General Here you can see the following information about the device:

Name The name of the current Inspector PIM60 (device). The
name can be changed. The name appears next to the
InspectorPIM60 menu.

Serial no The serial number of the connected Inspector PIM60
(device).

Save System Dump To save the contents of the memory of the Inspector,
click Save system dump. Select the directory where to
save the dump. This is only used for support provided
by SICK.

Network Here you can see the following information about the network:
TCP/IP The network configuration type; DHCP or Manually.
IP address The IP address and port of the current Inspector PIM60

(device).
Netmask The netmask of the current Inspector PIM60 (device).
Gateway The gateway address for the network.
Network speed The network speed for the current network connection.
MAC address The MAC address or the Ethernet ID for the network card

in the Inspector.

Set Password
To change the current password in the Inspector for user level Maintenance (used for Edit
mode), choose Set Password from the InspectorPIM60 menu. The Login dialog box is displayed.
Enter current password (default password is Inspector). Select user levelMaintenance. Enter
new password and re-enter new password. Click OK.
To remove password protection of Edit mode (user level Maintenance), set the password to the
default password Inspector.

Log Settings
To select which types of images that should be logged, choose Log Settings from the Inspector-
PIM60 menu. For more on image log see Chapter 22, “Log and store images” (page 115).
The 30 most recent images of the specified type are saved in the log. The images can be
viewed in the Logged images tab. The settings is also valid for storing images to FTP.

Store images to FTP
To store images to FTP. See Chapter 18, “Store images on an FTP server” (page 101) and
Chapter 22, “Log and store images” (page 115).

Save Settings in Flash Memory
To save all device data (settings) in the Inspector's flash memory, choose Save Settings in Flash
from the InspectorPIM60 menu. A progress bar is displayed during the process. When saving
to flash memory the function LED will flash white. The Inspector will stop analyzing images
until the flash memory is updated. For more information about device data, see Chapter 24,
“Handle device data” (page 120).
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Restore Settings
It is possible to restore settings and return to the factory settings. All device data will be de-
leted. To restore settings choose Restore Settings from the InspectorPIM60 menu. For more in-
formation about device data see Chapter 24, “Handle device data” (page 120).

7.4 Configuration workflow
The basic flow when configuring an application is described in the table below. The flow as-
sumes that the device is physically connected and that a connection to the Inspector PIM60
has been established. For more information on how to connect, see Section 5.2, “Con-
nect” (page 23) and Chapter 6, “Connect ” (page 30):

DescriptionSOPAS Engineering Tool (ET) GUI reference

To be able to change the settings click
Edit.
Adjust the image settings to obtain a
good image for the application and de-
cide on how to capture the image, see
Chapter 8, “Adjust image” (page 37).

Click Teach reference object to start config-
uring the application. See Section 5.4.1,
“Teach the reference object” (page 25).

Depending on the application type
choose one or more of the tools in the
Reference image tab

Configure the settings for the tools, see
Chapter 10, “Use the toolbox” (page 45).

Configure the settings for the digital
outputs, for example active time and
delay, see Section 14.3, “Use digital
outputs” (page 87). Optionally choose
to configure Ethernet based result output
from the Inspector PIM60, see Sec-
tion 16.2, “Output results” (page 94). If
other interfaces than the default digital
outputs are needed, configure this in the
Interface and I/O settings dialog and
Ethernet result output menus.

or

Click Run to set the device in operating
mode. If configuration should be perman-
ently stored on the device choose Save
to flash when asked if store to flash
memory should be done

Monitor the results for the analyzed im-
ages.

Monitor the statistics for the analyzed
images.
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8 Adjust image

8.1 Adjust focus
To adjust focus, place an object to inspect in front of the Inspector, so that it is visible in the
Live image tab.
Adjust the focus by turning the hex key on the top of the Inspector. Use the 2 mm Hex key
that came with the Inspector. Look at the Live image tab and adjust until the image is focused.

Figure 8.1 Adjust focus

8.2 Adjust image settings

Figure 8.2 Image settings

Adjusting Exposure and Gain settings changes the image quality. To adjust exposure time and
gain to good values, click Auto. The Auto adjustments will change exposure time and gain,
only after clicking on Auto, the settings will not change continuously.

Over exposed (reduce expos-
ure time)

Good exposureUnder exposed (increase ex-
posure time)

8.2.1 Adjust exposure
Exposure: amount of time imager is open to receive light. Measured in milliseconds (ms).
Increasing the exposure time results in brighter images, but may also result in a lower frame
rate.
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If the object is moving and exposure time is too long, the image will be blurred, which may
result in lower accuracy in the inspections. When a short exposure time is necessary because
of object speed, there are two methods to make the image bright enough:
• Use external high-intensity lighting
• Increase the gain
To adjust exposure time, drag the Exposure slider on the Image settings tab.

8.2.2 Adjust gain
The Gain setting is used for increasing the gain of an image after it has been captured. In-
creasing the gain may also increase the noise in the image and make it appear grainier. To
adjust gain, drag the Gain slider on the Image settings tab. Setting Gain to 100% means that
the image will be unaffected. A higher value means that the image will be brighter.

8.3 Use lighting
The Inspector has a built-in lighting using LEDs (Light Emitting Diodes).
There are four different combinations of how to use lighting:
• None, only ambient light is used, such as normal indoor light or sunlight
• Internal (or built-in) lighting
• External lighting
• Internal and external lighting

Figure 8.3 Use lighting options.

Note
The internal and external light are active during the whole exposure time.
For a robust solution, always use internal or external lighting (or both). It is not recommended
to only rely on ambient light.

8.3.1 Use internal lighting
To turn on (or turn off) the built-in lighting in the Inspector, select (or deselect) the Internal
check box on the Image Settings tab.

8.3.2 Use external lighting
Before the Inspector can use an external lighting, the type must be specified.
To use external lighting with the Inspector:
1. Select External on the Image Settings tab.
2. Choose the correct external light source from the list in the Set external lighting pop-up

dialog box.
3. Click OK
If a SICK ICL light source is used, the only configuration required is selecting the ICL-type in
the list and all other settings will be configured automatically. Note that if the selected expos-
ure time is longer than the maximum active time for the selected light source, then the ex-
posure time is automatically adjusted to this limitation.
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If a SICK light source used in combination with the VLR Trigger unit, the Other–active low choice
shall be selected from the list.

Non-SICK external light
If a non-SICK external light source is to be used, select Other – active high or Other – active low
depending on the specifications of the external lighting. The option Other – active high is used
for light sources that triggers on an active high signal (+5 V) and the option Other – active low
is used for light sources that triggers on an active low signal (0 V). The signal is active during
the whole exposure time, so adjust the Exposure setting to be lower than the maximum active
time for the light source. If the external illumination has duty cycle restrictions, use an image
trigger and adjust the trig rate so that the duty cycle of the light source is not exceeded.

Warnings
Do not use longer exposure time than what the external light is designed for. See the tech-
nical data for the light source.
Do not use shorter cycle time (frame rate) than what the external light is designed for. See
the technical data for the light source.

To handle the variations of surrounding light an ambient light compensation can be used,
see Section 20.5.1, “Enable Ambient light compensation” (page 110). To connect to an external
light see Section 14.3.6, “Connect an external light” (page 90).

8.4 Adjust image size/field of view
The image size is the size in pixels of the images captured by the Inspector.
The image size can be changed by changing field of view. Adjust the field of view so that the
Inspector only captures images of the area in which the objects are expected to be found.
The default field of view is the full area that the Inspector sees.
To change the field of view:
1. In the Image Size section of the Image settings tab, click Change.
2. In the Live image tab, resize the gray rectangle Valid FOV (field of view) region with the

handles. The Minimum FOV (red rectangle) depends on all applied regions, that must be
inside the field of view.

Reduced FOVFull FOV

3. Click Resize. The Inspector will now use the new image size.
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9 Calibrate and align

9.1 Overview
There are two main reasons for calibrating the Inspector:
• To compensate for perspective and lens distortion, and thereby improve the accuracy and

robustness.
• To be able to present values and positions in millimeters, as a unit of measurement instead

of pixels.
Once calibrated, the images captured by the Inspector will be rectified – that is, de-warped
and re-sampled to be straightened and de-warped, and distance measurements and positions
will be displayed in millimeters.

The rectified image.-An un-rectified image, where the chessboard
looks distorted due to the lens distortion.

A calibrated Inspector can also be aligned with an external coordinate system, for example
to get position coordinates in a robot's coordinate system instead of in the Inspector’s. Aligned
coordinates can be output on Ethernet. However, in SOPAS the positions are always displayed
in the Inspector’s coordinate system.
When using a calibrated Inspector, you should redo the calibration in the following cases:
• After changing lens, or removing and remounting the lens.
• After adjusting focus.
• When replacing the Inspector.
• When the working distance is changed.

Note
The same calibration will be used for all reference objects in the Reference objects list.
Calibration will not be used for objects with a reduced field of view. See Chapter 8, “Adjust
image” (page 37) for more information about adjusting the field of view.

When copying a configuration from a calibrated Inspector to another Inspector, you must first
calibrate the other Inspector. Importing a configuration from a calibrated Inspector will not
replace any existing calibration, but there must be a calibration available for the tool settings,
thresholds and other parameters that rely on measurements in mm instead of pixels.

9.1.1 Calibration target
The Inspector uses a chessboard pattern for calibration. There is a PDF containing a chess-
board pattern for printing on the www.sick.com PIM60 product pages. It is also possible to
create your own pattern.
If you print the provided calibration pattern, note the following:
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• Make sure that you print the PDF without scaling (or scale set to 100%), alternatively
measure the actual size of the squares after printing.
If the PDF is not printed at 100%, the square size printed on the pattern will not be accurate.

• Mount the pattern on a flat surface before using it.
If you create your own calibration pattern, note the following:
• No more than 50 x 50 squares should be visible in the image.
• Mount the pattern on a flat surface before using it.
• If the following pattern with three dots are visible in the image, the Inspector will use them

for positioning the origin of the coordinate system. Otherwise, the Inspector will place the
origin on the square corner closest to the center of the image.

y

x

Origin

• If you are aligning the Inspector, the four control points (A-D) should be placed at the
corners of a rectangle that is 24 squares wide, 18 squares high, and aligned with the
squares in the chessboard pattern.

9.2 Calibrate
To calibrate the Inspector, do the following:
1. Place the calibration pattern in front of the Inspector.
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• Place the pattern at the same distance from the Inspector as where the inspections
are made. For example, if you are inspecting lids on jars, don't place the pattern directly
on the conveyor belt:

Intended inspection height
Correct calibration height
Incorrect calibration height

• It is not necessary to see the entire chessboard in the image. However, at least 4 x 4
squares should be visible.

• The chessboard should preferably cover the entire image.
• The minimum length of a square's side should be 15 pixels.

2. If necessary, adjust focus, exposure and gain, see Chapter 8, “Adjust image” (page 37).
3. In the Image settings tab, click Calibrate.

Note
If the Inspector is already calibrated, the button is named Re-calibrate instead.

The Calibrate device window is displayed, showing an un-rectified live image of the calibra-
tion pattern.
A grid is displayed over the chessboard pattern.
The origin is shown as two thicker lines with the y-axis drawn on top of the x-axis.
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Origin
Grid dots

Note
The calibration is performed at full image size even if the image has been resized.

4. Enter the length (in mm) of the side of the squares in the calibration pattern. Use a
period (".") as a decimal separator.

5. Click Calibrate.
The calibration process is started, and may take more than one minute.
When the calibration process is finished, the rectified live image is shown in the window. The
calculated mean and max error (in pixels) is shown below the image, together with the pixel
size (in mm).

6. Click Close to start using the calibrated device.
To redo the calibration, click Re-calibrate in the Image settings tab to open the Calibration
wizard again.
To remove the calibration, click Remove calibration in the image settings tab.

9.3 Align to external coordinates
Alignment is a transformation of the sensor coordinates to an external coordinate system.
The procedure to find the transform is based on the known relation between the control
points (A, B, C and D) and the origin of the external system, as well as the origin of the sensor.
Using the calibration pattern requires only to derive the control points within the external
system, as the relation between the control points and the senor origin are known.
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1. Calibrate the Inspector. See Section 9.2, “Calibrate” (page 41).
2. Measure the external control point coordinates (A, B, C, and D points on the calibration

pattern).

Note
If the alignment to external coordinates is performed at a later stage, make sure that
the external control point coordinates has the same relation as during the calibration.

3. Click the Align to external coordinates button and enter the external control point coordinates
(X,Y, and Z values) into the Coordinate alignment window. Use a period (".") as a decimal
separator.

The Import external coordinates button offers a possibility to import the control point coordin-
ates into SOPAS using a text file.

Note
It is possible to enter the values into a Microsoft Excel worksheet and saving the data
to csv-file.

The values in the text file must be entered in the following format:

xA;yA;zA
xB;yB;zB
xC;yC;zC
xD;yD;zD

Where:
• xA;yA;zA is the X,Y, and Z coordinates for the control point A etc.
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10 Use the toolbox

10.1 General
The toolbox in the Inspector PIM60 contains three types of tools:
Positioning tools Used for locating objects of different shapes, or features such as

edges and circles, in the images.
Inspection tools Used for inspecting areas on located objects, or fixed areas in the

images.
Measurement tools Used for measuring distance and angle between located objects

or features.
Of the positioning tools, the Object locator is special since it can be used for positioning
other tools. This makes it possible to inspect and measure on an object without knowing
exactly where it is positioned in the image.
Each reference object can contain one Object locator, and up to 64 other tools. Up to 8 of
these tools can be Blob tools, up to 8 Polygon tools, and up to 4 Edge counter tools.

10.1.1 Add positioning and inspection tools
To locate an object or feature in the image, or inspect a part of the object in view, do the
following:

1. Make sure the Inspector is in Edit mode, and that the reference object is displayed in
the SOPAS window.

2. Click on one of the positioning or inspection tools in the toolbar.
3. Click and drag in the image to mark the region in which the tools should operate.

You can select the shape of the region from the shape buttons at the bottom right of
the image.

Figure 10.1 Add object locator by drawing a rectangle in the reference image.

Once the tool has been added to the reference object, it can be modified in the following
ways:
• Move the region by clicking inside it and dragging it to the new location.
• Resize the region by clicking and dragging the square handles on the sides of the region.
• Rotate the region by clicking and dragging the rotation handle on the top of the region.
• Change the shape of the region by selecting a different shape in the Tools tab.
• Mask out parts of the region by adding masks, using the Mask tool in the toolbar.
• Change other settings for the tool in the Tools tab.
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10.1.2 Add measurement tools
To measure a distance or angle, you must first add tools that locates the features that you
want to measure between, for example Edge or Circle tools.
Once the features can be located, do the following:

1. Make sure the Inspector is in Edit mode, and that the reference object is displayed in
the SOPAS window.

2. Click on one of the Measure tools in the toolbar.
The features that you can measure between are highlighted with a white circle in the
image.

3. Click on the features in the image that you want to measure from and to.
The measurement is displayed as a green line between the features.

4. If necessary, adjust the setting to get the measurement result you want.
For example, when measuring between two edges you can either measure the distance
between the reference points on the found edges, or the orthogonal distance (right
angle) from one edge to the point on the other edge.

Figure 10.2 Features are marked with white circles. Defined measurements are shown
as green lines.

To change the features used by an existing measurement, click Select features ( ) in the
Tools tab, and select the features to use instead in the image. You can also select the locator
tools directly from the menus Start and End respectively.
To change the direction of the measurement, which could be useful when measuring ortho-

gonal distances between edges, click Change direction ( ) in the Tools tab.

10.1.3 Common tool settings
Settings for the tools used in the reference object are available in the Tools tab. Selecting a
tool's area in the image will select the tool in the list of tools, and display the current settings
for that tool. Similarly, selecting a tool in the tool list will select the area in the image.
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Figure 10.3 Common settings for most tools.

Many of the settings for a tool are specific for the type of tool. These tool specific settings
are described in the following sections. There are however a number of settings that several
tools have in common:
Name A custom name that you can give to a tool, for easier identification of the

specific tool. This name is displayed in the tools list, and can also be used
when specifying the result that the Inspector should output.

Relative to Sets whether the tool's area should be positioned relative to the located
object, or in a fixed position in the image.
By default, all tools will be positioned relative to the located object if the
Object locator is used.

Type Shows the name and icon of the tool's type.
Shape Sets the basic shape of the tool's area to be either rectangular ( ) or el-

liptical ( ).
The shape of Polygon, Edge, Circle, and Measurement tools can not be
changed.

Masks The Masks list shows all mask regions that are attached to the tool's area.
• To display the mask list, click on the plus/expand button.
• To select a mask region in the reference image, click on the mask name

(Mask 1 etc) in the list. The mask names cannot be changed.
• To remove a mask right-click on the mask name and choose Delete.

Note
Masks can not be used on Polygon, Edge counter tools or Measurement
tools.
The Circle and Edge tools can each have one mask, but they are handled
differently from other masks. See Section 10.3, “Circle” (page 49) and
Section 10.4, “Edge tools (Edge)” (page 52) for more information.
The entire region for a tool must always be inside the reference image.
When the Inspector is analyzing captured images, regions relative to an
object locator may end up outside the image. In this case the correspond-
ing tool will fail.

10.1.4 Search direction of edge based tools
The direction in which edges are searched for in the region is indicated by the yellow arrows
on the region in the reference image. To change the search direction, simply rotate the region.

10.2 Object locator

The Object locator is used to locate an object that has a
known shape. The method uses a pattern matching

Object locator
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function that recognizes and compares edges in the im-
age.
The reference point (purple cross) is by default placed
in the center of the object locator region, but can be
moved manually to the particular point on the object that
should be reported. The reference point for the object
locator can be moved with either the mouse or the arrow
keys on the keyboard.

Configure the settings for the Object locatorTeach the shape to be located in Reference
image tab

10.2.1 Setting
The edges that will be searched for are those inside the object locator region (blue rectangle),
that are outlined with green contours. The following settings can be made for the object loc-
ator:
Edge strength The amount of contours found is adjusted with the Edgestrength slider.

The Edgestrength setting determines how much of the object's contours
that are highlighted. In most cases, you should make sure that most
of the characteristic contours in the object are highlighted but nothing
is highlighted in the background or outside the object. Use the Mask
tool to mask out areas of the region that is outside the object if it is
difficult to make the pixels in the area around the object disappear
with the Edge strength setting.

Match TheMatch setting determines how well the located object must match.
The match score can be set between 0% and 100%, but the most
common value of match is between 30%-70%. Move to the left (lower
values) if the Inspector fails to locate objects, move to the right
(higher values) if the Inspector claims to locate objects that are not
of the correct shape.

Allow rotation The Allow rotation setting consists of a check box and a slider. If Allow
rotation is enabled, the allowed rotation can be set between zero and
±180°. Disable Allow rotation if the object always appears with the
same rotation as in the reference image, this speeds up the inspec-
tions and makes it more robust.

Allow objects any-
where in image

The Allow objects anywhere in image setting is used to determine where
in the image to search for objects. When selected, the Inspector will
locate objects that are partially outside the image (although with a
lower score). When disabled, you can specify the region (Search region
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in green color) in which the objects are allowed. Objects located
outside or partially outside this search region will not be located.

Allow Scaled Objects
(±20%)

The Allowscaledobjects setting is used when objects appear at different
distance from the Inspectors lens. Disable Allow scaled objects if the
inspected objects always have the same size in the image as the
reference object. Disabling Allowscaledobjectswill speed up and make
the inspections more robust. When selected, the Inspector will locate
objects that are scaled up to ±20%.

Advanced – Search
Method

See Section 20.1, “Object locator” (page 108).

10.2.2 Results
The object locator reports Located if an object in the image passes all thresholds that are
defined in the setting. If any of the thresholds fails, the result is Not located.
In addition to the Located/Not located result, the object locator produce the following values:
• The Match score [percent].
• The X and Y position of the reference point on the located object [pixels or mm].
• The rotation of the located object, relative the object in the reference image [degrees or

radians].
• The size (scale) of the located object, relative to the object in the reference image.

10.3 Circle

The Circle tool locates a circle within the region. It can
be used for example for verifying the diameter of a circu-

Circle

lar hole, or as a end point of a distance measurement.
See Section 10.13, “Distance” (page 71) for more inform-
ation.
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Figure 10.4 Circle tool.

10.3.1 Settings
Edge contrast The Edge contrast setting specifies the required contrast

of the circle's edge - that is, the minimum difference in
intensity between the dark side and the bright side of
the edge. Move the slider to the left to detect circles
that have a small difference between the dark and the
bright side. Move the slider to the right to limit the circles
to those with a large intensity difference between the
sides.

Circle fit criteria The circle with the strongest edge con-
trast.

Strongest

Smallest The smallest circle found that is larger
than the minimum diameter.

Largest The largest circle found that is smaller
than the maximum diameter.

Polarity Sets the transition of the circle's edge from the centre
of the circle – from bright to dark, from dark to bright,
or any.

Circle fit:
Smallest
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Circle fit:
Largest

Circle quality Move the Circle quality slider to the left (towards Toler-
ant) to allow the Inspector to locate circles that are not
perfectly circle shaped, or where the circle's edge is
rough.
Move the slider to the right (towards Exact) to make the
Inspector ignore circles that are not round enough.

Rough circleElliptical circlePerfect circle

Search method Adjusts the method used for searching for the circles.
Move the slider towards "High speed" if your application
requires high inspection speed and you are locating
circles in a small region with high contrast. Move the
slider towards "High robustness" if you are locating
circles in a large region, or if the region contain for ex-
ample much background clutter, heavy shadows, low
contrast, or much occlusion.

Circle When selected, the Circle tool will find circles where the
circle's perimeter is located between the specified
minimum and maximum diameter.

Circle with search region When selected, the Circle tool will search for circles
anywhere within a search region.

Note
Due to performance reasons, the inner circle area must
be equal to at least 1/15th of the search region area.

Circle with mask When selected, you can mask out a section of the circle
to prevent the Inspector to search for the perimeter in
that area. This can be useful for example when locating
circles that are partially covered.
To change the width and the position of the mask, click
and drag the white bars in the region.
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Figure 10.5 Circle with mask.

Repeatability improvement When Circle with mask is selected, you can improve the
robustness of the tool by using the fix diameter or the fix
position parameter.

Offset compensation A fixed value that will be added to (or subtracted from)
the fitted circle's diameter.
This is useful if there is a systematic measurement error
in the application, and you would like to set limits or get
results that are adjusted for this error. Note that the
circle shown in the image is not affected by this com-
pensation.

10.3.2 Results and tolerances
The Circle tool will pass if the located circle passes both these tolerances:
Score Reflects how well the fitted circle matched the circle's edge in the region. Adjust

the score threshold so that the Circle tool gets the red failed status when no
circle is present in the region.

Diameter Sets the minimum and maximum allowed diameter for the located circle.
In addition to the Pass/Fail results, the Circle tool produces the following values:
• The Score for the fitted circle [0...100].
• The diameter of the fitted circle [pixels or mm].
• The X and Y position of the center on the fitted circle [pixels or mm].

10.4 Edge tools (Edge)
The Edge tool locates an edge within the region. It can be used for verifying the presence of
an edge in the area, find the first or last point in the search direction, and also as a part of
a distance or angle measurement. See Section 10.13, “Distance” (page 71) for more inform-
ation.

Locates a straight edge within a region and
fit a line to that edge.
When Edge is selected, the Edge tool will
fit a line to the edge inside the area that
best matches the settings for the tool.

Edge
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Figure 10.6 Edge settings.

10.4.1 Settings
Enable mask When selected, you can mask out a part of the region, to make the

Edge tool ignore edges inside that area. This can be useful for ex-
ample when locating an edge that is partially covered by a label.
To resize the mask, click the masked area and drag the white bars
in the region.

Edge contrast The Edge contrast setting sets the required contrast of the edge -
that is, the minimum difference in intensity between the dark side
and the bright side of the edge. Move the slider to the left to detect
edges that have a small difference between the dark and the bright
side. Move the slider to the right to limit the edges to those with a
large intensity difference between the sides.

Polarity Sets the transition of the edge in the search direction – from bright
to dark, from dark to bright, or any.

Criteria If there are multiple edges in the region that have the required edge
strength, the criteria sets which of the edges that should be located:

Polarity:
Any

Polarity:
Dark to bright

Polarity:
Bright to dark

Criteria: First
The first edge
found in the
search direc-
tion.

Criteria: Last
The last edge
found in the
search direc-
tion.

Criteria:
Strongest
The edge with
strongest con-
trast.
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Edge quality Move the Edge quality slider to the left (towards Tolerant) to allow the
Inspector to locate edges that are not perfectly straight, or when the
edge is noisy.
Move the slider to the right (towards Exact) to make the Inspector ig-
nore edges that are not straight enough.

10.4.2 Results and tolerances
Score Reflects how well the fitted line matched the edge in the region. Adjust

the score threshold so that the Edge tool gets the red failed status
when no edge is present in the region.

In addition to the Pass/Fail result, the Edge tool produces the following values:
• The Score for the fitted edge [0...100]. (Only for Edge, not Find maximum).
• The X and Y position of the center on the fitted edge [pixels or mm].
• The rotation of the fitted edge, relative to the image [degrees or radians].

Tip
If you need the positions of the end points of an edge, use a Polygon tool instead of an Edge
tool. See Section 10.9.3, “Algorithm - Single edge tool” (page 65) for more information.

10.5 Edge tools (Find maximum)
The Find maximum tool locates the first or last edge point along the search direction of an
inspection region.

The Find maximum tool will place a line at
the first (or last) point in the search direc-
tion, of the first (or last) edge with the set
edge contrast. This line will always be
perpendicular to the search direction.

Find maximum

Figure 10.7 Find maximum settings.

10.5.1 Settings
Enable mask When selected, you can mask out a part of the region, to make the

Edge tool ignore edges inside that area. This can be useful for ex-
ample when locating an edge that is partially covered by a label.
To resize the mask, click the masked area and drag the white bars
in the region.

Edge contrast The Edge contrast setting sets the required contrast of the edge -
that is, the minimum difference in intensity between the dark side
and the bright side of the edge. Move the slider to the left to detect
edges that have a small difference between the dark and the bright
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side. Move the slider to the right to limit the edges to those with a
large intensity difference between the sides.

Polarity Sets the transition of the edge in the search direction – from bright
to dark, from dark to bright, or any.

Criteria If there are multiple edges in the region that have the required edge
strength, the criteria sets which of the edges that should be located:

Polarity:
Any

Polarity:
Dark to bright

Polarity:
Bright to dark

Criteria: First
The first edge
found in the
search direc-
tion.

Criteria: Last
The last edge
found in the
search direc-
tion.

Criteria:
Strongest
The edge with
strongest con-
trast.

Edge quality Move the Edge quality slider to the left (towards Tolerant) to allow the
Inspector to locate edges that are not perfectly straight, or when the
edge is noisy.
Move the slider to the right (towards Exact) to make the Inspector ig-
nore edges that are not straight enough.

10.5.2 Results and tolerances
Score Reflects how well the fitted line matched the edge in the region. Adjust

the score threshold so that the Edge tool gets the red failed status
when no edge is present in the region. Not valid for Find maximum.

In addition to the Pass/Fail result, the Edge tool produces the following values:
• The Score for the fitted edge [0...100]. (Only for Edge, not Find maximum).
• The X and Y position of the center on the fitted edge [pixels or mm].
• The rotation of the fitted edge, relative to the image [degrees or radians]. Not valid for Find
maximum.

Tip
If you need the positions of the end points of an edge, use a Polygon tool instead of an Edge
tool. See Section 10.9.3, “Algorithm - Single edge tool” (page 65) for more information.
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10.6 Edge counter
The Edge counter tool locates multiple edges within the region and calculates the distance
between each edge and its neighbour. It can be used for verifying the number of edges in
the area, or for verifying an even distribution of the edges.
The Edge counter tool is available in two variants:

Locates edges along a line. Pitch is meas-
ured in pixels or mm.

Linear

Locates edges along a circle. Pitch is
measured in degrees.
Useful for example when counting spokes,
or inspecting the teeth on a cog wheel.

Circular

You select which variant to use by selecting it from the popup menu that appears when you
click on the Edge counter icon in the toolbar.

10.6.1 Settings
Edge contrast Sets the required contrast of the edges - that is, the minimum differ-

ence in intensity between the dark side and the bright side of an
edge. Move the slider to the left to detect edges that have a small
difference between the dark and the bright side. Move the slider to
the right to limit the edges to those with a large intensity difference
between the sides.

Figure 10.8 Edge counter settings.
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Feature type Sets whether the tool should locate line features or single edges:

Bright lines on dark backgroundBright

Dark lines on bright backgroundDark

Single edges, which are transitions
from dark to bright, or from bright to
dark

Single
edge

When set to Bright or Dark, the pitch is measured from the center of
the located features.

Feature width When Feature type is set to Bright or Dark, the Feature width setting
sets the minimum and maximum allowed width of the located fea-
tures.
Clicking Auto width will set the allowed feature width according to the
features that the Inspector locates in the region in the reference im-
age.

Polarity When Feature type is set to Single edge, the Polarity setting sets the
transition of the edge in the search direction – from bright to dark,
from dark to bright, or any.

Edge quality Move the Edge quality slider to the left (towards Tolerant) to allow the
Inspector to locate edges that are not perfectly straight, or when the
edges are rough.
Move the slider to the right (towards Exact) to make the Inspector ig-
nore edges that are not straight enough or if the edges are narrowly
spaced.

Search method Adjusts the method used for searching for the edges. Move the slider
towards High speed if your application requires high inspection speed
and you are locating edges in a small region with high contrast. Move
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the slider towards High robustness if you are locating edges in a large
region, or if the region contain for example much background clutter,
heavy shadows, low contrast, or much occlusion.

10.6.2 Results and tolerances
The Edge counter tool will pass if these tolerances are met:
Number of features The number of single edges or line features that are allowed in

the region.
Pitch The minimum and maximum distance between two adjacent

edges or features.

Note
The calculated mean pitch value is shown in parentheses next
to the Pitch setting.

In addition to the Pass/Fail result, the Edge counter tool produces the following values:
• Number of edges

The edge counter supports at most 64 edges. When more edges are located, the GUI
will show ">64" as a result for edges found. The Ethernet result output will output 65
edges.

–

• Mean, maximum and minimum pitch [pixels or mm]
• For each edge when locating single edges:

– The X and Y position of the center on the fitted edge [pixels or mm]
– The rotation of the fitted edge, relative to the image [degrees or radians].
– The polarity of the edge

• For each feature when locating line features:
– The X and Y position of the fitted center on the feature [pixels or mm]
– The rotation of the fitted centre of the feature, relative to the image [degrees or radians].
– The width of the feature [pixels or mm]
– Internal angle - that is, the angle between the two edges defining the feature [degrees

or radians]

10.7 Blob

The Blob tool is used to locate the position of one or more
free-form shapes (the so-called "blobs"). The method

Blob

uses a Blob tool function that recognizes objects of any
shape in the image. A blob can either be dark object on
a bright background, or bright object on a dark back-
ground. The located blob is found among pixels grouped
together in a user configured intensity interval where the
blob size matches a user configured area interval. It is
possible to insert up to eight blob ROI on a reference
object.
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Reference object image with a blob tool
search region. The green areas mark the

Original image as seen in the SOPAS Engineer-
ing Tool (ET), Live Image tab

blobs in correct intensity range. The two blobs
without reference point are too big and too
small compared to the configuration size
settings

The found blobs that meet the selection criteria are marked with purple crosses at the each
blob's Center of Gravity (COG). The first blob in the configured Sort by setting is marked with
a purple cross with a purple circle around it. If the Blob tool is used by a Distance measure-
ment, the position of the first blob will be used in the measurement.

Figure 10.9 Blob tool configuration tab.
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10.7.1 Settings
The following settings can be done for the blob tool:
Intensity Choose the Intensity interval with the sliders, for pixels

to be selected to be inside a blob.
Area Choose the blob Area interval for a shape to be selected

as a blob.

Note
For area calculation, the area of the holes in the found
blobs is included in the area that is calculated.

Calculate Structure Enable or disable calculate structure
Inspection Edge Strength See information about Inspection Edge Strength in

Section 10.2, “Object locator” (page 47), and note in
Section 10.12, “Edge pixel counter” (page 71). The
settings of Inspections Edge Strength affects all inspec-
tions in the same reference object.

Advanced settings
- Search method Adjusts the method used for searching for the blobs:

• Move the slider towards "High speed" if your applica-
tion requires high inspection speed and the region
contains little disturbance or noise apart from the
blobs themselves.

• Move the slider towards "High robustness" if the re-
gion contains much disturbances or noise.

- Allow border blobs Enable to allow blobs that touches the border of the
blob search region.

- Sort by Choose the sorting order for the found blobs. This will
be the order in which the blobs are presented in the
Results tab as well as in the Ethernet result output.

- Angle Choose the Angle of rotation for the blob. The calcu-
lated/reported angle is always a positive value between
0º and 180º. See Section 10.7.3, “Use blob
angle” (page 61) for explanation on how the angle is
calculated and reported.

- Angle tolerance Choose the Angle tolerance which is between 0º to ±90º.
See Section 10.7.3, “Use blob angle” (page 61).

- Ambient light compensation See Section 20.5, “Blob” (page 110).

10.7.2 Results
Number of blobs Sets the number of blobs that should be found by the blob tool.

Up to 15 blobs can be found within an ROI. If this slider is set to 16,
the result will be set to passed if 16 or more blobs are found.

In addition to the Pass/Fail result, the blob tool produces the following values:
• The number of found (and qualified) blobs.
• For each found blob:

– The X and Y position of the center of gravity [pixels or mm].
– The area [pixels or mm]
– The angle [degrees or radians]
– The structure value [pixels]
– Whether or not the blob touches the border of the blob region.

• The upper and lower intensity threshold after compensating for ambient light.
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10.7.3 Use blob angle
The blob angle is the angle between the x-axis and an axis around which it would be easiest
to rotate the blob. This angle will always be between 0º and 180º, since the Inspector does
not distinguish between a blob and the same blob rotated 180°.

Reference point
Blob rotation axis in the xy-plane which is the axis around which it would be easiest to
rotate the blob
The angle of rotation is calculated as the angle between the blob rotation axis and the
horizontal, x axis in the image

When specifying the allowed rotation of blobs, two values are set; Angle and Angle tolerance.
If for example Angle is set to 10° and Angle tolerance to ±45º, the range of allowed blob angles
would be from -35° to 55°. But since the angle reported by the Inspector is always between
0° and 180°, the resulting blob rotations will be either in the range 0° to 55° or in the range
(180°-35°) to 180°.

Allowed range of blob rotationSpecified Angle
Max allowed positive rotation of the blob Actual rotation of the blob

Reported angles of rotation, since the
Inspector PIM60 always reports an angle
in the interval 0º to 180º.

Max allowed negative rotation of the
blob

10.7.4 Use blob structure criteria
The structure criteria can be used to inspect if a blob has a smooth or a rugged surface. The
resulting structure is a measurement of the number of edges inside a blob. When locating
objects that have two (or more) sides the structure measurement can be used to identify the
side facing up.
In the example image below the Structure criteria, or more specifically the number of edges
inside a located blob, is used to evaluate which side is facing up, heads or tails.
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The resulting image after blob selection with
use of structure criteria. The first blob in ac-

The original image of coins.

cordance with the Sort by sort order is marked
with a cross with a circle around it.

If Structure and Edge strength settings are configured to be used and the resulting Structure is
outside the boundaries, the blob(s) will be regarded as not located. Vice versa, if Structure is
of no interest, set the structure boundaries to default, that is min to 0 and max to 1000000.

The Blob tools Structure setting to select blobs.

Note
The edge pixels on the edge of the blob are not counted as a part of the Structure

10.7.5 Number of blobs
The result output from the blob tool contains information about the number of located blobs
and can be used for applications where there is a need to count and verify the presence of
a certain number of blobs.
An example would be to count and verify that the correct number of pins are present on a
power connector, see the following images.
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Live image counting blobs.Photo of the power connector (right).

10.8 Pattern

The Pattern tool locates a gray scale pattern pixel by
pixel within a region.

Pattern

Figure 10.10 Pattern Inspection.

10.8.1 Settings
Reference point The reference point (purple cross) marks the position of the

pattern that is reported in the results, and can be used for
measurements.
You can move the reference point from the default location (the
center of the region) to the particular point on the object that
shall be reported.

Position tolerance The position tolerance specifies the maximum positional offset
between the pattern in the region and the reference image. The
tolerance can be set from 0 to +-4 pixels.

10.8.2 Results
Match The Match threshold sets the required similarity between the pixels of the region

and the reference image. The setting is a value between 0 and 100%, where 100%
means "perfect match".

In addition to the Pass/Fail result, the pattern tool produces the following values:
• The score value for the located pattern [0...100].
• The X and Y position of the reference point [pixels or mm]
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10.9 Polygon (not included in PIM60 Bead P/N 1076617, 1079321,
1079322)

The polygon tool is used for localization of corners on an
object or localization of an object's edge. The corner po-

Polygon

sitions are estimated with high accuracy which enables
for fine localization of objects. The number of corners in
a polygon can vary from 2 (single edge tool) to 16 and
the polygons can either be closed or open. A closed
polygon means that the starting point is the same as the
end point. For closed polygons there is also an optional
functionality to detect cracks or other defects along the
polygon.
In general the polygon tool requires object edges with
high contrast and a uniform image background for
reaching the adequate robustness. This is especially
important when using the crack/defect detection in order
to get a robust tool.
A polygon will give a Detailed failed result if the match
score is lower than the configured threshold or if the
defect detection, if enabled, fails. More detailed inform-
ation can be output by using Ethernet Result Output.

10.9.1 Adding a polygon
• Select the Polygon icon below the reference image to draw a polygon in the image. Click

once for each corner point and lines will be drawn connecting them.
• The polygon may either be closed or open. A closed polygon has the same start and end

point. When placing the mouse pointer near the start point, the cursor changes shape.
Then click to close the polygon.

Tip
An open polygon with two lines is well-suited for positioning a corner.

• If an open polygon is wanted, move the mouse pointer near the end point of the latest
drawn line, make sure that the cursor changes shape, and click to finish the polygon.

The shape and position of this drawn polygon only need to be approximate since the algorithm
will search and fit the drawn polygon to the edges found in the image. The fitted polygon is
drawn in green in the reference image, or red if it is not found.
The polygon corners can be edited after the polygon has been drawn. Select the polygon by
clicking on it in the image or in the list in the Tools tab. Then click on one of the corner points
and drag it to a new position with the mouse. The whole polygon can also be moved when
selected by using the arrow keys on the keyboard.

Note
It is not possible to add/remove corner points once the polygon is drawn. Also, it is not possible
to close an open polygon or vice versa. To remove a polygon, select it in the image or in the
list in the Tools tab and press Delete or select Delete polygon in the right-button menu.

10.9.2 Algorithm
The polygon fitting is performed in two steps:

keeps the object shape and size1. Rigid positioning

allows for shape deformation2. Flexible fitting
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The rigid positioning step keeps the exact shape and size of the drawn polygon. It searches
for the position and rotation that fits this shape to the edges in the image. The search is
performed locally around the line segments.
The flexible fitting step allows the fitted polygon shape to deviate from the drawn shape.
Each line segment of the polygon is fitted independently. This is useful when the drawn shape
is imperfect, when objects have variations in shape, or when the calibration is imperfect.
The figure below shows an example. The user drawn polygon to the left is drawn yellow.
Around this polygon is a search area for the rigid positioning. The gray polygon in the image
does not perfectly match the drawn shape, but the coarse position and rotation is found in
the rigid positioning step and drawn blue in the center image.

After flexible fittingAfter rigid positioningDrawn polygon with search area

After this step, the flexible fitting fits each line segment of the polygon to the edges of the
image. This is drawn blue in the right image. The new corners are computed as the intersection
of the fitted line segments. These corners are limited not to deviate too much from the rigidly
fit corners. This limitation is drawn as red circles in the figure.

10.9.3 Algorithm - Single edge tool
The single edge is a special case of the polygon, i.e. a polygon with two corners. This requires
for a slightly different algorithm where only the rigid positioning is required. The rigid positioning
step searches for the edge with the highest contrast in the search region, which is specified
by the position search parameter (see image below).

Figure 10.11 Illustration of the search region.

There are some limitations if the algorithm shall be able to find the edge:
• The angle between the edge and the user drawn edge must be less than 45 degrees.
• The found edge must cross the left and right borders of the search region (see image below).
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Figure 10.12 No edge will be found if the edge does not cross the left and right borders
of the blue search region.

The estimated corner positions are the intersection between the found edge and the left and
right borders of the search region. The corner positions are illustrated as black square in the
figure below.

Figure 10.13 Illustration of the estimated corner positions (black squares).

10.9.4 Parameters
The following settings can be made for the polygon tool:
Position search A search area can be defined by using the Positionsearchparamet-

er. Controls the extent of the rigid positioning. Avoid having values
larger than approximately half of the object side since the Inspect-
or PIM60 may find other edges than the wanted.

Flexibility search Control the amount of flexibility. This parameter limits the dis-
tance between the rigidly fitted corners and the flexibly fitted
corners. If the object has a solid shape and it is only moved or
rotated the value of Flexibility search should be low. A value of
0 means that no flexibility is allowed. It is not optimal to set a
low value since it is difficult to draw the exact polygon for the
object. Set a value of 3-4 for example to have a margin of error.
Observe that the flexibility search parameter is not valid when
the single edge tool is used.

Score Reflects how well the flexibly fitted polygon matched the edges
of the image. It is based on the line segment with worst fit. Adjust
the score threshold so that the polygon tool gets the red failed
status when no polygon is present in the image.

Polarity Use Polarity to get a robust analysis setup. With the polarity an
edge can easier be found by the polygon tool. There are two dif-
ferent polarities; one where the object is bright and the back-
ground is dark and the other where the object is dark and the
background is light. The polarity icon in the image should match
the object. See the following pictures.
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One can see how well the results of the score is met if the correct
polarity is selected. Default value is no polarity selected.

Polarity not chosen.Wrong polarity
chosen.

Correct polarity
chosen.

10.9.5 Defect detection
Click the Defect detectioncheck box to inspect the polygon's sides for cracks or similar defects.

Figure 10.14 The polygon tool parameters.

The inspection is a regular pixel counter. The pixels to be inspected are placed along a strip
inside the polygon, see next figure. The width of the strip is controlled by the Widthparameter.
The Margin parameter positions the strip at a safety margin from the found polygon line seg-
ments.

Note
Defect detection can only be performed on closed polygons and not on open polygons.

Pixel counting works in an identical way to the Pixel counter tool. All pixels within the Intensity
rangeare counted. If these are more thanMaxdefect pixels, the tool will get the red failed status.

Figure 10.15 Pixels inside the green strip are inspected to find defects.

There is a trade-off between the minimal defect size to be found and the avoidance of false
detections. Having a small margin allows for smaller defects at the risk of getting false detec-
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tions. This trade-off is also controlled with the Maxdefect pixelsparameter. The minimum value
of Margin and Max defect pixels depends on many application specific issues such as:
• contrast and focus
• straightness of the sides of the objects
• size and shape of cracks
• illumination
The pixels inside the strip are inspected row by row starting from the top of the image. A red
cross marks the first pixel within the Intensity range. If there are many defects only the first is
marked.

Note
The SOPAS User Interface colors all defect pixels within the complete polygon yellow, but only
the pixels within the strip are counted

10.10 Bead tool (only included in PIM60 Bead P/N 1076617,
1079321, 1079322)

The Bead tool verifies completeness, position and width
tolerance of string-formed features, for example glue
beads.

Bead tool

Figure 10.16 Bead tool settings.
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10.10.1 Adding a bead tool
• Select the Bead tool icon below the reference image to start positioning the Bead tool.

Click once for each corner point, connecting lines are drawn automatically. The shape
should be drawn in the center of the bead. When the basic shape of the bead is completed,
specify the width in the settings panel.

• A maximum of 16 corners can be used when the Bead tool is applied.
• To complete the Bead tool without placing all 16 corners, move the mouse pointer near

the end point of the last drawn line, make sure that the mouse pointer changes icon and
click to finish the bead.

• After completing the beat tool, adjust the minimum and maximum width so that the edges
of the string are within the desired width span.

10.10.2 Settings

Figure 10.17 Bead tool probes. Center and width.

Edge strength Set the required contrast of the edges, that is, the minimum
difference in intensity between the dark side and the bright side
of an edge. Move the slider to the left to detect edges that have
a small difference between the dark and the bright side. Move
the slider to the right to limit the edges to those with a larger in-
tensity difference between the sides.

Min width Set the minimum width (in pixels) of the bead string to search
after.

Max width Set the maximum width (in pixels) of the bead string to search
after.

Bead intensity Set the intensity of the bead string. Use the Bright setting if the
bead is brighter than the background and the Dark setting if the
bead is darker than the background.

Min probe distance Set the distance (in pixels) between each probe pair used by the
algorithm. A short probe distance will provide a more precise
trace of the bead string. The maximum probe pair count is 256.
The actual probe distance can change depending on the length
of the drawn bead string. If the probe pair limit has been reached,
the distance between them will be increased in order to cover
the entire bead.

10.10.3 Results and tolerances
Position tolerance Set the number of pixels the Bead tool is allowed to

move in any direction from the position in the reference
image. This is visualized by a pink line along each bead
segment.

Longest sequence of too narrow
probes

Set the number of consecutive probe pairs that are al-
lowed to have a width which is smaller than specified.
This tolerance is useful for detecting gaps in the bead.

Longest sequence of too wide
probes

Set the number of consecutive probe pairs that are al-
lowed to have a width which is greater than specified.

69©SICK AG • Identification & Measuring • www.sick.com • All rights reserved
Subject to change without notice

8015728/2018-10

How ToUse the toolboxOperating Instructions
Inspector PIM



Total amount of too narrow probes Set the number of total probes (consecutive or not) that
are allowed to have a width smaller than specified.

Total amount of too wide probes Set the number of total probes (consecutive or not) that
are allowed to have a width greater than specified.

10.10.4 Improve speed
To improve Bead tool speed:
• Increase probe distance
• Reduce the size of the search region, that is the difference between min and max width.
• Decrease position tolerance.

10.11 Pixel counter

The Pixel counter inspection tool makes an inspection by
counting pixels within a certain gray scale range. The

Pixel counter

matching pixels are marked with yellow graphics and the
value is compared with the No. of pixels in range interval
setting.

Figure 10.18 Pixel Counter Inspection.

10.11.1 Settings
Intensity Range The Intensity range specifies which pixels in the region

that the Pixel counter should count. These pixels are
highlighted (yellow) in the image. The interval is selected
by the two sliders, that specify dark (left) upper limit and
light (right) lower limit. The highlighted (yellow) area is
those pixels that are in between the both slides.

Number of Pixels in Range The No. of pixels in range interval is specified as number
of pixels within the inspection region. If the located ob-
ject is scaled, the number of pixels is adjusted to be the
number of matching pixels that should have been found
if the located object had the same size as the reference
object.

Note
If the inspection region is changed the number of pixels
in range will not automatically be changed

10.11.2 Results
In addition to the pass/fail result based on the No. of pixels in range setting, the pixel counter
can output the number of pixels in the range as a value.
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10.12 Edge pixel counter

The Edge pixel counter tool counts pixels that are edges
and compares this number with the No. of edge pixels set-
tings. Where the pixels are located does not matter.

Edge pixel counter

Figure 10.19 Edge Pixel Counter Inspection.

10.12.1 Settings
Inspection edge strength The Inspection edge strength settings sets the minimal

contrast required for a pixel to be marked as an edge.
These pixels are highlighted (yellow) in the reference
image.

Note
The Inspection edge strength setting affects all Edge pixel
counter and Blob inspections in the reference object.
The Inspection edge strength setting for detailed inspec-
tions is different from Edge strength used in the Object
locator tab.

Number of Edge Pixels The No. of edge pixels interval is specified as number of
pixels within the inspection region. If the located object
is scaled, the number of pixels is adjusted to be the
number of matching pixels that should have been found
if the located object had the same size as the reference
object.

Note
If the inspection region is changed the number of pixels
will not automatically be changed

10.12.2 Results
In addition to the pass/fail result based on the No. of edge pixels setting, the Edge pixel
counter tool can output the number of edge pixels as a value.

10.13 Distance

The Distance tool measures the distance between loc-
ated features; edges, circles, edge intersections a, pat-

Distance

terns, blobs, and known shapes located with the Object
locator. When blobs are used in a measurement, the
position of the first blob located by the tool according to
the sorting order will be used.

aAn edge intersection can be located with the Angle tool.

71©SICK AG • Identification & Measuring • www.sick.com • All rights reserved
Subject to change without notice

8015728/2018-10

How ToUse the toolboxOperating Instructions
Inspector PIM



Figure 10.20 Measure distance.

10.13.1 Settings
Start and End Select the objects or features to measure from and to respect-

ively.
To change which features to measure between, you can do any
of the following:
• Choose the start and end features from the Start and End

menus respectively.
• Click Change direction to switch the measurement direction -

that is, change place of the start and end features.
• Click Select features, and select the new features in the image.

Type When at least one edge is used in the measurement, select
which distance to measure:

The distance
from the refer-
ence point on
the edge.

Point-to-point

The orthogon-
al distance
from the
edge.
Whenmeasur-
ing between

Right angle

two edges,
select which
of the edges
to measure
from by click-
ing Change
direction.

Measure When at least one circle is used in the measurement, select
which distance to measure:
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From the center of the
circle.

Minimum distance -
from the nearest point
on the circle's perimet-
er.

Maximum distance -
from the point on the
circle's perimeter that is
furthest away.

Offset compensation A fixed value that will be added to (or subtracted from) the
measured distance.
This is useful if there is a systematic measurement error in the
application, and you would like to set limits or get results that
are adjusted for this error. Note that the distance shown in the
image is not affected by this compensation.

10.13.2 Results and tolerances
Distance Sets the minimum and maximum allowed distance between the two features.
In addition to the pass/fail result based on the Distance setting, the Distance tool produces
the following values:
• The measured distance [pixels or mm].
• A Valid result, indicating whether any of the features used by the measurement could not

be located (the corresponding locator tool failed).
To get the distance in millimeters instead of pixels, you must first calibrate the Inspector.
See Chapter 9, “Calibrate and align” (page 40) for more information.

10.14 Angle

The Angle tool measures the angle between two edges
located by Edge tools. In addition to the angle, the tool

Angle

also calculates the intersection point between the two
edges, which can be reported in the result, or can be
used for distance measurements.

Note
If the edges are almost parallel, no intersection point will
be calculated, and any measurement using the intersec-
tion point will therefore fail.
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Figure 10.21 Measure angle.

10.14.1 Settings
Start and End Select the Edge tools to measure from and to respectively.

To change which features to measure between, you can do any
of the following:
• Choose the start and end features from the Start and End

menus respectively.
• Click Change direction to switch the measurement direction -

that is, change place of the start and end features.
• Click Select features, and select the new features in the image.

Offset compensation A fixed value that will be added to (or subtracted from) the
measured angle.
This is useful if there is a systematic measurement error in the
application, and you would like to set limits or get results that
are adjusted for this error. Note that the angle shown in the
image is not affected by this compensation.

10.14.2 Result and tolerances
Angle Sets the minimum and maximum allowed angle between the two edges.
In addition to the pass/fail result based on the Angle setting, the Angle tool produces the
following values:
• The measured angle [degrees or radians].
• The X and Y position of the intersection of the two edges [pixels or mm].
• A Valid result, indicating whether any of the features used by the measurement could not

be located (the corresponding locator tool failed).
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11 View result and statistics

11.1 Results
The inspection result is displayed in the Results tab. The upper part of the Results tab shows
the digital output signals and overall result information. The digital outputs can be configured
in the Digital output settings tab.

Figure 11.1 Example Output result.

Name of reference object
The name of the reference object is displayed above the results. This is the same name as
in the Reference objects list.

Overall results
Three different results are presented:

The object was located and all detailed inspections passed as well.All passed

The object was located but at least one detailed inspection failed.Detail failed
A detailed inspection that is not related to an object locator failed.

The object was not located at all.Not located
The object was located but at least one detailed inspection was out of view.

It is possible to get both Detail failed and Not located in the same image, if the reference object
has both an object locator and a detailed inspection that is not related to the object locator.
However, it is not possible to get All passed at the same time as any other result.

Outputs
The status of the outputs is displayed in the Results tab. The color of the output indicates the
status:

StatusColor

Active outputYellow

Inactive outputWhite

Not available outputGray

Active output can correspond to either a high or a low signal. See Section 14.3.5, “Invert
output signals” (page 90).

Detailed results
The detailed results for the different tools are presented in the lower part of the Result tab.
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Figure 11.2 Detailed results of different tools

For each tool, the overall result is indicated by the bullet in front of the tool name:

The result was within the thresholds.Pass

The result was outside the threshold, or no object or feature was found.Fail

The tool could not produce a result, for example if the tool area was partly
outside the image, or one of the features used in a measurement was not found.

Not valid

The bar to the right of the tool name shows the value used for the pass/fail result. The used
thresholds are shown as black lines on the bar.
Object locator, Pattern The Match value.
Edge The Score value.
Find maximum The Position value.
Circle Two bars are shown for the circle tool, one for the Score value,

and one for the Diameter.
Edge counter Two bars are shown for the Edge counter tool, one for the

Edges or Features found value, and one for the Pitch.
Polygon The Score value.

If defect detection is selected, the number of defect pixels is
shown in a separate bar below the score.

Pixel counter, Edge pixel
counter

The number of counted pixels or edge pixels.

Distance, Angle The measured distance or angle.
In addition to the pass/fail result and values, some tools display additional result values in
the Detailed results:
Object locator, Edge The position and rotation of the located object or edge.
Circle The position of the center of the located circle, and the dia-

meter.
Distance, Angle The measured distance or angle.
Blob Instead of a bar, the number of located blobs is displayed,

together with the position, rotation, area, and calculated
structure of each blob.

For uncalibrated devices, the position is measured from the upper left corner of the image.
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For calibrated devices, the position is measured from the place where the origin was placed
with the chessboard pattern. (See Chapter 9, “Calibrate and align” (page 40) for more inform-
ation).
If the Inspector is calibrated the values are displayed in millimeters (mm), otherwise in pixels.
More detailed results can be obtained through the Ethernet based interfaces, see Chapter 16,
“Use Ethernet Raw” (page 94) for more information..

11.2 Statistics
Statistics are collected for each reference object used by the Inspector. The statistics are
updated in Runmode for the currently selected reference object, and all other reference objects
are resting until selected.
The statistics is started to be updated as soon as the selected reference object is being used
for inspections (Run mode). Switching between different reference objects will add to the
statistics for each reference object until the statistics is reset.

Note
If any reference object settings are changed, then the statistics will be reset for that particular
reference object.

The statistics is displayed in the Statistics tab.

Figure 11.3 Statistics tab

To update the statistics, click Fetch statistics. The following statistics are collected for each
reference object:
Number of acquired images Total number of captured images.
Frame rate The current maximum frame rate in Hertz (Hz). The same

value as under the live image.
Minimum delay time The latest minimum delay time in milliseconds (ms).

The same value as under the live image.
Number of ignored trigger pulses Loosing trig pulses can happen if you are using an ex-

ternal image trigger (in3) and the inspected objects are
moving too fast (too high speed on conveyor belt).

Number of overflow trigger pulses This can happen if there is a long distance between the
image trigger and the Inspector (where the image is
captured) and/or if there is a long distance between the
Inspector and the rejecting device connected to the In-
spectors output signals. The Inspector needs to remem-
ber all objects in the queue, the queue can be too long
if the inspected objects are moving too fast (too high
speed on conveyor belt).
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Number of inspections The number of inspections in the reference object. Ob-
ject locator region and masks are not counted. This is
a static value.

Number of images with timeout in
Blob tools

The total number of captured images where the Blob
tool timed out and reported no found blobs. The Blob
tool can time out when the image is cluttered and high
speed is used.

Not located The total number of captured images where an Object
locator did not locate a shape, or an inspection related
to the object locator was outside the image. The result
is presented in percent of all captured images.

Detailed failed The total number of captured images where one or more
detailed inspections failed. When the Inspector is only
locating without making detailed inspections, no images
will be counted. The result is also presented in percent
of all captured images.

All passed The total number of captured images where the object
was located and all detailed inspections passed (if any).
When the Inspector inspects without locator, images
with all detailed inspections passed will be counted.

Click Reset statistics to empty the statistic information.

8015728/2018-10©SICK AG • Identification & Measuring • www.sick.com • All rights reserved
Subject to change without notice

78

Operating InstructionsView result and statisticsHow To
Inspector PIM



12 Work with multiple objects
The Inspector PIM60 can store up to 32 different reference objects, making it easy to switch
between different inspection tasks with different reference objects.

12.1 Teach additional objects
To teach an additional object:
1. Under the Reference objects list, click Add. A new reference object is created. This new

object is empty, without a reference image.
2. Place a new object in the Inspector's field of view and adjust image settings. Click on

Teach reference object to create an additional object. A new reference image is placed in
the image container.

3. To change the name of the reference image, double-click on the name, and type a new
name.

12.2 Select reference object
The time it takes to switch reference object depends on the number of inspections, inspection
type and sizes of the regions in the reference object. The following table gives an overview
of the times taken, in milliseconds:

Typical time for reference object
selection

Reference object configuration

500 msOnly Object locator

700 msObject locator plus four Blob inspections

700 msObject locator plus four Pixel Counter inspections

600 msObject locator plus four Edge Pixel Counter inspections

700 msObject locator plus four Pattern inspections

700 ms (5 corners)Object locator plus one Polygon inspections

700 msObject locator plus four Edge tools inspections

900 msObject locator plus four Edge counter inspections

800 ms (4 edges)Object locator plus two Distance inspections

700 ms (4 edges)Object locator plus two Angle inspections

600 msObject locator plus four Circle inspections

100 msFour Pixel Counter inspections

200 msOnly one Blob inspection

12.2.1 Select object using SOPAS
To select which reference object to be used for the inspections/when inspecting:
1. Select Edit mode, by clicking Edit.
2. In the Reference objects list, click on the desired reference object
3. Click Run, to start the inspection. Save the configuration to flash memory if the Inspector

has to restart or in case of power failure.

12.2.2 Select reference object with interfaces and I/O
Apart from SOPAS Engineering Tool (ET) there are a number of alternative ways to select active
reference objects:
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• To use the digital inputs on the Inspector, see Section 14.2.4, “Select reference objects
with inputs” (page 86)

• To use the digital inputs on the I/O Extension box, see Section 14.4, “Set up the connection
I/O extension box” (page 90)

• To use the default web pages, see Chapter 17, “Use web interface” (page 97)
• To use the interface EtherNet/IP, see the reference manual for Inspector PIM60
• To use the interface Ethernet Raw, see the reference manual for Inspector PIM60
• To use the interface Web API, see the reference manual for Inspector PIM60

12.3 Duplicate reference objects
To duplicate a reference object:
1. Right-click on source reference object and select Copy to new reference object from the pop-

up menu.
2. The new reference object is placed at the end of the Reference objects list.
To change the name of the reference image, double-click on the name, and type a new name.

12.4 Settings for multiple reference objects
Some settings in SOPAS Engineering Tool (ET) are unique for an individual reference object
and some settings are common for all reference objects.
The settings made in the Configuration pane in the Main view and some other functions are
unique for an individual reference object:
• Image settings
• All tools: Object locator, Circle, Edge, Blob, Pattern, Polygon, Pixel counter, Edge pixel

counter, Distance, and Angle
• Digital Output Settings
• Ethernet Result Output
Other settings – made from the InspectorPIM60 menu – are global and applies to all reference
objects, for example:
• Interfaces and I/O settings
• Log settings
• Calibration
• Store images to FTP
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13 Interfaces

13.1 Overview interfaces
Inspector PIM60 is designed to interact over a number of different interfaces in order to
easily be integrated into centrally controlled machine designs. Apart from the digital interface
there are several optional interfaces to cyclically tap the result, retrieve image and control
the device by sending commands. Below image shows a summary of all interfaces. See
Section A.4, “Technical specification” (page 126) for explanation of which device is supported
of which interfaces.

I/O extension boxEthernet Raw

Digital I/OEtherNet/IP

SOPAS ETWeb API

Power 24 VWeb Server

Store images to FTP

Figure 13.1 Overview interfaces to Inspector PIM60

The enabling and configuration of the optional interfaces are made via the Interface and
I/O settings and Store Images to FTP dialogs accessed via the InspectorPIM60 menu. See
figure below. SOPAS ET is enabled simply by a connection between it and a device.

Figure 13.2 Interfaces and I/O settings dialog for Inspector PIM60

13.2 Simultaneous use and restrictions of the interfaces

Not possible combinations of interfaces
The interfaces can be used simultaneous except for the following restriction:
• Only one of Ethernet Raw and EtherNet/IP can be used at a time.
• The I/O extension box and EtherNet/IP can not be used at the same time. The built-in di-

gital I/O can however be used at the same time as EtherNet/IP.

Image sending restrictions
Sending images to several interfaces will decrease performance on the least prioritized inter-
face. The image interfaces are prioritized as follow with highest priority listed first:
1. Store Images to FTP
2. SOPAS Engineering Tool (ET)
3. Send images over web server and Web API
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When SOPAS is connected to a device, live images are not sent by the device's web server
or the Web API.

Configuration restriction
It is not recommended to have SOPAS Engineering Tool (ET) in online mode while sending
configuration changes via other interfaces. This can cause problems with the connection
between SOPAS Engineering Tool (ET) and Inspector PIM60. The problem may occur when
a command with a long execution time, is executed.
Examples of such commands are calibration and save to flash memory. If the problem occur
a message is shown that SOPAS Engineering Tool (ET) has lost connection to Inspector
PIM60. An attempt to reconnect will be done. When the sent command has been executed,
the SOPAS Engineering Tool (ET) is able to connect to Inspector PIM60 again. A synchroniz-
ation dialog will also appear, select Use Device Settings to update SOPAS Engineering Tool
(ET) with the latest configuration.
It is also recommended to avoid changing settings in SOPAS Engineering Tool (ET) while
sending configuration changes via other interfaces.
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14 Use digital I/O

14.1 Overview digital I/O

Digital Inputs
The Inspector PIM60 has four built-in digital inputs that can be used for different purposes:
• Teach reference object (in2)
• Trigger inspections (in3)
• Encoder (in4)
• Select which reference object to use when inspecting (in1...in4)
For the built-in digital inputs that have two purposes only one purpose can be chosen at the
same time. The input signals are shown in the figure.

10 – In4

8 – In1

3 – In3

5 – In2

To use a digital input for triggering inspections, encoder input or teaching objects, connect
the signal to its input on the Inspector PIM60 and set the usage of the input in SOPAS Engin-
eering Tool (ET). By default digital inputs are disabled.
Any input that is not used for trig, encoder or teach signals can be used for reference object
selection. For example, if an encoder is used, in4 should be set as encoder input but the re-
maining three inputs can be used for object selection, making it possible to select between
up to eight objects with the inputs.

Digital outputs
The Inspector PIM60 has three built-in outputs and can be used for different purposes:
• Not located (Out 1)
• Detailed failed (Out 2)
• All passed (Out 3)
The above list is the default value of the digital outputs, the value can be changed.

Overview I/O extension box
The Inspector PIM60 can be connected to an I/O extension box that increases the number
of digital inputs and outputs. The I/O Extension box is available as an accessory from SICK,
see Section A.5, “Accessories ordering information” (page 128) details.
The number of inputs can be increased by using a I/O extension box. The increase of input
is needed when input selection can not be achieved on the built-in digital inputs. Up to five
additional inputs can be configured on the I/O box.
The number of outputs can be increased up to 19, when using I/O extension box, however
it is not possible to set any output delay on the external output.
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14.2 Use digital inputs

14.2.1 Use external teach
To be able to re-teach reference objects without using a PC, do the following:
1. Choose Interfaces and I/O Settings from the InspectorPIM60 menu, and select Use external

teaching in Digital I/O tab.
2. Make sure the Inspector is in Run mode. Place an object in front of the Inspector and

connect in2 (pin 5, cable color is pink on DOL-1212 cables) to +24 V. After about 3
seconds, the Inspector will start capturing images and flash with the lighting, if used.
Also, the Function LED will start flashing.

3. Adjust focus by turning the focus screw. The frequency with which the Function LED is
flashing indicates how focused the images are – the faster it flashes, the better the focus.
If re-focus is needed due to distance change between the object and Inspector turn the
mechanical focus screw and adjust with help of the function LED.

4. Find the field of view (that is, the area covered in the captured image) by using a finger,
a pen or similar. When the finger/pen enters the field of view, the color of the Function
LED changes from green to blue. The LED color reacts on motion in the image. Ensure
that the finger/pen is moving and that the rest of the scene is stationary.
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5. When done, disconnect in2 from the power. The Inspector will now use the most recent
image as the reference image, and learn the contours of the object in view. All device
data is saved in flash memory. During the flash memory storage, the Function LED flashes
white.

6. The Inspector will then automatically switch to Run mode and start the application with
the taught reference object. The procedure may take about 15 seconds.

Note
• The Inspector must contain a reference object, using external teach will only replace the

reference image for the active reference object and change the exposure settings (exposure
and gain). The exposure settings can also be kept by enabling Use current exposure settings
in the Interfaces and I/OSettings dialog in Digital I/O tab. Any modifications made to the refer-
ence object will remain, for example if the object locator region has been resized.

14.2.2 Connect an external image trigger
To use an external trigger for triggering the Inspector PIM60 to capture the images, do the
following:
1. Connect the image trigger to in3 (pin 3, cable color is white on DOL-1212 cables) on the

Inspector.
2. Choose Interfaces and I/O Settings from the InspectorPIM60 menu, and select Enable image

trigger (In3) in the Digital I/O tab.
3. Under Triggering in the Image settings tab, select Triggered by In3 and choose whether the

images should be triggered on the Rising edge (from 0.1 V to +24 V) or on the Falling edge
(from +24 V to 0.1 V).
You can also set a delay between the trigger pulse and when the image is captured, by
specifying a delay time in milliseconds or number of encoder pulses.
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Note
• If there are multiple reference objects, you must choose Triggered by in3 for each ref-

erence object for which images should be triggered. It is possible for the Inspector to
have reference objects where image capturing should be free-running for some and
triggered for others.

• The image trigger and the Inspector should be connected to a common ground, to
avoid problems with signals not being registered properly by the Inspector.

14.2.3 Connect an encoder

10 – in4

To use an encoder for controlling delay times for image triggering and/or output signals, do
the following:
1. Connect the encoder to in4 (pin 10, cable color is violet on DOL-1212 cables) on the In-

spector.
2. Choose Interfaces and I/O Settings from the InspectorPIM60 menu, and select Use encoder

(In4) the Digital I/O tab.
3. Set the delays to be a number of encoder pulses:

Image capture delay are set on the Image settings tab for the reference object.•
• Output delays and active times are set on the Digital output settings tab by setting the

delay and/or active times in the Fixed fields.

Note
• The encoder and the Inspector should be connected to a common ground, to avoid problems

with signals not being registered properly by the Inspector.
• The maximum encoder frequency is 40kHz.

14.2.4 Select reference objects with inputs

10 – In4

8 – In1

3 – In3

5 – In2

To be able to select objects with the inputs on the Inspector, you must first set up which
combination of inputs that should select each object.
1. Select Interfacesand I/OSettings from the InspectorPIM60menu, and select the Enableexternal

object selection in External object selection tab.
2. Select which input signals to be used for object selection. If an input is already used for

image triggering, encoder or external teach, that input cannot be used for object selection
and the check box for that input is therefore disabled.

3. Select which Reference objects to activate for each combination of inputs. The object is
selected from the drop down menu. The Inputs number is the binary value with the selected
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input signals (in2 etc). The most significant binary digit is in2 (if used) or the one with the
lowest number. The digit “0” means that the corresponding input is active low and the
digit “1” means that the corresponding input active high.

4. Click OK when all settings are complete.

Important
• When selecting a reference object with the digital inputs, the input signal levels must be

kept during the time that the reference object should be used. As soon as the input signal
changes, another reference object will be selected instead.

• The device providing the signals and the Inspector should be connected to a common
ground, to avoid problems with signals not being registered properly by the Inspector.

• When the built-in inputs are not enough there is need to use an I/O extension box or one
of the Ethernet interfaces to achieve the input selection. For more details about I/O box
see Section 14.4, “Set up the connection I/O extension box” (page 90).

14.3 Use digital outputs
The result from each inspection made by Inspector PIM60 can be mapped to any of the built-
in outputs, or to the outputs of a connected I/O extension box. The outputs in the table are
the default outputs.

Activated whenLED color FunctionPinOutput

Not located – The object was not located, or a detailed
inspection was out of view

Blue4Out1

Detail failed – The object was located but at least one of
the detailed inspections failed

Red6Out2

All passed – The object was located and all detailed in-
spections passed as well

Green7Out3

Normally the output signal level is low (0 V) when inactive and high (+24 V) when active, that
is active high, but signals can be inverted.
The inspection result output settings are configured in the Digital Output settings tab.
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Figure 14.1 Digital output settings tab - I/O box enabled

14.3.1 Digital output settings tab
The Digital Output settings tab contains the detailed control of the output signals.
The displayed settings are for the selected reference object, except the Invert output signals
setting.

List of outputs
All available outputs are shown in the list. The digital outputs on the Inspector PIM60 are
called Out1, Out2 and Out3. If the I/O extension box is used, the outputs on the I/O extension
box are added to the list. The outputs on the I/O extension box are called Ext1, Ext2 etc.
Each output can be mapped to All passed, Detail failed, Not Located, or any user defined
expression. In Inspector PIM60 a Store Images to FTP overflow warning signal can also be
mapped to an output from the Store Images to FTP dialog box.

Assign logical expressions to outputs
The user defined expressions are created in the Digital Output Expression Editor.
In the Digital output settings tab for the Inspector PIM60, it is possible to define which ex-
pression that shall be used to control each output.
To select an expression for an output:
1. Click on the Expression column of the output to edit.
2. Choose the desired expression from the list.

14.3.2 Digital output expression editor
The Digital Output Expression Editor is opened by clicking the button Edit expressions… in
the Digital output settings tab. The editor is used to create and modify the expressions to
use for the outputs. Each learned object can have up to 16 expressions.
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Figure 14.2 Digital Output Expression Editor

An expression is either the result of a single detailed inspection or a logical combination of
two detailed inspections for a learned object. If an inspection is relative to a locator and the
objector locator is not found, the inspection will be reported as fail. The inspections can be
combined in two ways; logical AND, and logical OR. For each of the inspections, it is possible
to specify if it shall pass or fail.
To create a new expression using the Digital Output Expressions Editor:
1. Choose the learned object from the list.
2. Click on the Add button.
3. Enter a name for the new expression.
4. Choose the detailed inspection(s) to use for the expression, and specify if each inspection

shall pass or fail by clicking the appropriate button.
5. Choose the logical operation to perform on the result(s).
6. Save the new expression by clicking Apply.
The field for logical operation has three possible states and the expression will be true if:
[empty] Only the first condition is fulfilled.
AND Both conditions are fulfilled.
OR At least one of the conditions is fulfilled.
The selected expression can be removed by clicking the button Remove.

Note
• If the removed expression is in use, the corresponding output will be set to Not used.
• If a detailed inspection that is used by an expression is removed, the corresponding expres-

sion will be modified. If the expression only contains the inspection that was removed, the
expression will be removed, too.

14.3.3 Set output delay
The delay is always counted from when the exposure of the image started. To set a delay on
a built-in output:
1. Select the output in the list on the Digital output settings tab.
2. Set the output delay by selecting either:

The delay will be as short as possible – minimum delay time – which is the
same as the time it takes the Inspector to make the inspection.

Minimum

The inspection time depends on many different settings for the current ref-
erence object. The time is displayed below the image in the Live image and
Reference image tabs.

Fixed Set the delay as a time (in milliseconds) or a number of encoder pulses.
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When setting a delay in encoder pulses, the encoder should be connected to in4, and this
input should be reserved as an encoder input. To do this, see Section 14.2.3, “Connect an
encoder” (page 86).

Notes
If you set the delay time to be shorter than the minimum delay time, a warning will be displayed
and the minimum delay time will be used.
If the delay is set in encoder pulses, and the time these take when inspecting is shorter than
the minimum delay time, the trig pulse is ignored. The number of ignored trig pulses is dis-
played in the Statistics tab, see Section 11.2, “Statistics” (page 77).

14.3.4 Set output active time
The active time is always counted from when the output signal is activated. To set the active
time for a built-in output:
1. Select the output in the list on the Digital output settings tab.
2. Set the active time by selecting either:

Hold until result changes The output will be active as long as the inspection
result does not change.
Once the inspection result changes, the output will
change. Note that the deactivation of the output
will be after the output delay time.

Fixed Set the active time as a time (in milliseconds) or a
number of encoder pulses.

14.3.5 Invert output signals
Normally the output signal level is low (0 V) when inactive and high (+24 V) when active, that
is active high. You can change this by selecting Invert output signals on the Digital output settings
tab. When inverted, all output signals will be +24 V when inactive, and 0 V when active.

14.3.6 Connect an external light
To connect an external light, do the following:
1. Connect the external light to Ext trigger (pin 9, cable color is red on DOL-1212 cables) on

the Inspector.
2. For settings in SOPAS Engineering Tool (ET) see Section 8.3.2, “Use external light-

ing” (page 38).

14.4 Set up the connection I/O extension box
The following basic steps are required to use the I/O extension box with the Inspector PIM60.
For details about the steps see the reference manual for the Inspector PIM60.
1. Connect the I/O extension box to the network.
2. Configure the IP address of the I/O extension box to match the settings of the network,

and the Inspector PIM60. See Section 6.1, “Manage IP address” (page 30) how to view
the IP address for the Inspector PIM60.

3. Open the Interfaces and I/O Settings dialog under the Inspector PIM60 menu. In the tab Inter-
faces check the I/O extension box. Enter the IP address of the I/O extension box in the I/O
extension box setup tab in the same dialog.

4. In the External object selection tab activate the inputs and/or outputs on the I/O extension
box depending on the application.
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Note
The SOPAS Engineering Tool (ET) application should be closed or set to offline when the
power to the I/O box is disconnected. The I/O extension box needs to be restarted if the IP
address is changed or if the connections to the inputs and output on the box are changed.
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15 Use EtherNet/IP
The Inspector PIM60 can be controlled and results retrieved using the EtherNet/IP standard.
To be able to do this the connection has to be set up first.

15.1 Set up the connection EtherNet/IP
To set up the connection between the Inspector and a PLC and, do the following:
1. Choose Interfaces and I/O Settings from the InspectorPIM60 menu.
2. On the Interfaces tab, select Ethernet and choose EtherNet/IP from the menu.
3. On the EtherNet/IP tab, choose input assembly to be used.

For more information on the available assemblies, see the reference manual for Inspector
PIM60.

4. If configurations changes via EtherNet/IP should be allowed, select Allow changes via Eth-
erNet/IP.

5. Switch the Inspector to Run mode.
6. Set up the communication on the PLC. For information on how to do this, please refer

to the documentation for your PLC.

Note
Activating EtherNet/IP will have impact on maximum frame rate.

To specify the contents of the EtherNet/IP assembly, use the Ethernet Result Output dialog on
the InspectorPIM60 menu.

15.2 Output results
1. Choose Ethernet Result Output from the InspectorPIM60 menu.
2. Choose a Reference object from the list.
3. Set Message Settings.
4. Click Create example string.
5. Edit the formatting string to format the output as required.

Clicking Insert tags will show a menu where you can select the tags available for each tool.

6. Click Validate output string to validate the formatting string.
By clicking Export XML..., you can export the current formatting string to a file, which can then
be opened in an XML editor for editing.
To import an edited formatting string, copy the string from the XML editor and paste it into
the Formatting string for Ethernet Output field. Remove the <MESSAGE> and </MESSAGE> tags
from the Formatting string for Ethernet Output field before clicking Validate output string.

8015728/2018-10©SICK AG • Identification & Measuring • www.sick.com • All rights reserved
Subject to change without notice

92

Operating InstructionsUse EtherNet/IPHow To
Inspector PIM



15.3 Control the sensor via EtherNet/IP
The Inspector PIM60 has two Output assemblies that can be used for controlling the Inspector.
To do this the connection has to be set first, which is described in Section 15.1, “Set up the
connection EtherNet/IP” (page 92).
The Output assembly is used for controlling the Inspector in the following ways:
• Reference object selection
• External teach
• Image trig
• Change device mode (run/edit)
• Read and change parameters for configured tools and inspections
For more information about using command channel and EtherNet/IP, see the reference
manual for Inspector PIM60.
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16 Use Ethernet Raw
Coordinate and angle results, as well as other detailed results and information, can be reported
by the Inspector PIM60 as binary values or as ASCII strings via Ethernet communication. The
format of the string can be arbitrarily user defined and can be different for each reference
object.

16.1 Set up the connection Ethernet Raw
Do following to set up the result reporting via Ethernet Raw:
1. Choose Interfaces and I/O Settings from the InspectorPIM60 menu
2. On the Interfaces tab, select Ethernet and choose Ethernet (Raw) from the menu.
3. On the Ethernet Raw tab, select the Ethernet protocol (TCP or UDP) to be used for the

communication.
For UDP, also enter the IP address of the PC/PLC in Receiver IP address.

4. If necessary, change the Port number. The default TCP port number that the Inspector
PIM60 listens to is 2114.

5. If configurations changes via Ethernet Raw should be allowed, select Allow changes via
Ethernet Raw.

16.2 Output results
1. Choose Ethernet Result Output from the InspectorPIM60 menu.
2. Choose a Reference object from the list.
3. Set Output Settings. Select whether the results should be sent in ASCII (text) or binary

format.
4. Set Message Settings.
5. Click Create example string or Create JSON example string depending on the output format re-

quirement.
Clicking Insert tags will show a menu where you can select the tags available for each tool.

6. Edit the formatting string to format the output as required.
7. Click Validate output string to validate the formatting string.
By clicking Export XML..., you can export the current formatting string to a file, which can then
be opened in an XML editor for editing.
To import an edited formatting string, copy the string from the XML editor and paste it into
the Formatting string for Ethernet Output field. Remove the <MESSAGE> and </MESSAGE> tags
from the Formatting string for Ethernet Output field before clicking Validate output string.
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16.3 Control the sensor via Ethernet Raw
The command channel makes it possible to read and write a defined set of configuration
parameters, and to trigger image acquisition, via UDP or TCP. This section describes how to
setup image triggering and command channel settings in SOPAS, as well as the syntax of
the command channel.
• External teach
• Image trig
• Reference object selection
• Change device mode (run/edit)
• Read and change parameters for configured tools and inspections

16.3.1 Set up the connection Ethernet Raw command channel
The Inspector PIM60 supports a set of commands in order to read and/or modify parts of
the configuration without using the SOPAS Engineering Tool (ET) PC application. By default,
port 2115 is used for this communication. For image trigger port 2116 is used by default.
As default the command channel is configured to use UDP. The channel can be switched to
TCP or disabled in the Ethernet Raw tab in the Interfaces and I/O settings dialog (InspectorPIM60
menu). To enable the Ethernet Raw tab, first choose Ethernet Raw in the Interfaces tab in the
same dialog.
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Figure 16.1 Ethernet Command Channel

Note
When using the command channel for changing the configuration it is recommended not to
use SOPAS Engineering Tool (ET) for configuration simultaneously.

For more information about using command channel and Ethernet Raw see the reference
manual for Inspector PIM60.

16.4 Communicate with Simatic S7 controls
The Inspector PIM60 supports communication with Simatic S7-300 controls via so called
Function Blocks. For more information about using communication with Simatic S7-300
controls see the reference manual for Inspector PIM60.
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17 Use web interface
There are two main ways to connect to an Inspector PIM60 through the web interface:
• Use a web browser to open web pages served by the Inspector's built-in web server.
• Retrieve and change parameters, settings, etc. directly through the Web API from custom

application.
The Inspector PIM60 is delivered with a set of web pages that you can use for viewing live
images, current reference image, and logged images, and also switch between reference
objects in the configuration. You can backup the current configuration to a PC, as well as
restore the Inspector's configuration from a saved backup.
It is possible to create custom web pages, upload them to the Inspector, and access them
through the built-in web server. When you create custom web pages, all functions available
through the Web API can be used.

17.1 Set up connection to the web server
To set up connection to the web server do the following:
1. Choose Interfaces and I/O Settings from the InspectorPIM60 menu.
2. Click on the Interfaces tab, and select Web Server.

If this box is checked it will be possible to connect the Inspector PIM60 via the web
server and the Web API.

3. Click on the Web Server tab, and select Allow changes via Web Server to be able to use the
Web API commands.
By default, the web server listens to port 80. Some firewalls do not allow communication
on port 80, if so, change this value to a port allowed by the firewall. If the used port is
another than 80 write the following address in the browsers address field:
http://<ip-address>:<portnumber>. The port given in the address field must be
the same in SOPAS Engineering Tool (ET).

Figure 17.1 Set up connection to the web server

Note
Activating the web server will have impact on maximum frame rate.

17.2 Default web page
To open the default web page on the Inspector PIM60, start a web browser and type in the
IP address of the Inspector in the address field.
By default, the web server listens to port 80, but if you have specified a different port for the
web server in Interfaces and I/O Settings, you need to add the used port number after the IP
address, for example:
http://169.254.184.60:8080

The web server can be used with Internet Explorer 8, Mozilla Firefox 14 or Chrome 30.
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Figure 17.2 Main window in Web Server.

The default web pages have following tabs:
Start View information about the Inspector, such as IP address,

MAC address, version number of current firmware, and serial
number.

Live Image View the current live image.
• Show or hide the overlay graphic in the image with the Show
Overlay, the Simplified Overlay, and the Hide Overlay buttons.

• Change the refresh rate by pausing the image and changing
the value in the Refresh interval field.

• Magnify parts of the image by moving the mouse pointer
over the image while the live image is paused.

Reference Image View the current reference image.
To switch to another reference object in the current configur-
ation, click on the Handle Configurations tab, and then on Select
Reference Object. You must be logged in to be able to switch
reference object.

Logged Images View the logged images on the Inspector.
• Show or hide the overlay graphic in the image with the with

the Show Overlay, the Simplified Overlay, and the Hide Overlay
buttons.

• Browse through the images with the arrow buttons on the
sides of the displayed image, or click on the thumbnails
below the image.

The maximum number of images that can be displayed is 5.

Handle Configuration Used for backing up the current configuration to a PC,
restoring a configuration from a saved backup, and switching
reference object.

User Web Pages Used for uploading and removing custom web pages.
For the functions that requires you to log in - change reference object, restore configuration
from backup, and handle user web pages - use the following login:
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User Maintenance

Default password Inspector

If the password for the Inspector has been changed using SOPAS, use the password that has
been set for user level Maintenance.

17.2.1 Backup and restore configuration
To backup or restore configurations, click on the Handle Configuration tab, and then on Save
Backup or Restore Backup.
You must be logged in to be able to backup and restore configurations.

Note
Configuration files saved in SOPAS (.sdv files) can not directly be used for restoring from
the web page. To use a configuration file from SOPAS, export it as an .spb file first.

When restoring a configuration from a backup file, the Inspector will be stopped if in Run
mode, and it will be rebooted when the backup file has been uploaded. The restored config-
uration will automatically be stored in the Inspector's flash memory, replacing any previous
configuration.

17.2.2 Upload and remove custom web pages
To upload or remove custom web pages, click on the User Web Pages tab.
• To upload a file to the Inspector, click Browse... to locate the file, and then click Upload to

store the file on the Inspector.
When the file is stored on the Inspector, it will be added to the list of already uploaded
files. All files uploaded to the Inspector will be placed in the user folder, and can be ac-
cessed by:
http://<ip address>/user/<file name>

• To remove a file that has been uploaded to the Inspector, click Delete after the file's name
in the list of files already uploaded.

You must be logged in to be able to upload and remove custom web pages.

Figure 17.3 Page for uploading and removing custom pages.

Note
The space available for custom web page files on the Inspector PIM60 is limited to 2 MB,
and the maximum size of each file that can be uploaded is 200 KB.
A maximum of 236 files can be uploaded to the Inspector PIM60.
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17.3 Creating custom web pages
When you create custom web pages to be uploaded to the Inspector, you can use all functions
available in the Web API. For more detailed information see the reference manual for Inspector
PIM60.

17.4 Web API
With the Web API interface you can build your own applications that communicate with In-
spector PIM60 over the HTTP protocol. The command set used is the same as used for Eth-
ernet Raw. In addition Web API has a function for import and export device configuration.
For more detailed information see the Reference Manual for Inspector PIM60.
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18 Store images on an FTP server
The Inspector PIM60 can store logged images on an FTP server, which enables the user to
review the images.
For detailed information on how to store images on an FTP server, see Chapter 22, “Log and
store images” (page 115). See also Chapter 13, “Interfaces” (page 81)
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19 Improve image quality

19.1 Change lens
It is possible to change the lens on Inspector PIM60 in order to operate at different working
distances and to be able to fit the field of view (FOV) for a better inspection. A special tool is
required to open the front window of the Flex housing and to replace the standard lens. The
tool is delivered in the Inspector PIM60 package.
To replace the standard lens of the Flex housing:
1. Open the front window of the Flex housing using the large end of the supplied tool.
2. Remove the standard lens by using the small end of the tool.

3. Attach the new lens. Depending on the focal distance of the lens, and the working dis-
tance, one or more distance rings may be necessary.

Note
• The default lens is 10 mm.
• Refer to the table below for the correct number of distance rings to use.
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Horizontal/vertical FOV size in mm (inch) 

Figure 19.1 Theoretical FOV size (640x480 pixels)

Table 19.1 Lens and working distances

Working distanceDistance ringLens

100 mm – 140 mmBlack (3 mm) + Silver (1.5 mm)Focal length 16 mm

140 mm – 600 mmBlack (3 mm)

600 mm - ∞Silver (1.5 mm)

50 mm – 120 mmSilver (1.5 mm)Focal length 10 mm

120 mm - ∞None

50 mm - ∞Silver (1.5 mm)Focal length 8 mm

50 mm - ∞NoneFocal length 6 mm

4. Attach the front window again to the Flex housing.
After replacement, both the lens and the front window must be securely fastened to prevent
them from falling off during operation.

Important
• To keep IP 67 classification, open and close the front window only with the supplied tool.

Make sure that the seal fits properly.
• To avoid damages, only Inspector accessory lenses offered by SICK must be used.
• Minimize the risk of getting dust into the device by changing the lenses in a dust-free en-

vironment. Do not keep the device without the front window. Wipe off the front window
and the Inspector before you remove the front window.
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19.2 Improve reflex avoidance
When working with shiny objects there might be a need to minimize the effects of the reflexes
produced by the surface. This can be done in two ways:
• Mount a Dome accessory to the device that diffuses the internal lighting
• Tilt the device with an angle towards the inspection area

19.2.1 Dome
It is possible to replace the front window with a Dome lighting. The Dome lighting diffuses
the internal lighting in order to improve performance when working with glossy objects.
When using a Dome lighting the optimal working distance is 50mm. Depending on the object
being inspected other working distances may also work well. For example objects with flat
and less glossy surfaces could possibly be inspected at a larger distance.
A special tool is required to open the front window of the Inspector. The tool is delivered in
the Inspector Flex package.
To replace the front window with the Dome:
1. Open the front window of the Flex housing using the large end of the supplied tool. See

the left image below.

2. Attach the Dome to the Flex housing by hand.
After replacement, the Dome must be securely fastened so that there is no risk of it falling
off during operation.

Important
• To keep IP 67 classification, open and close the front window only with the supplied tool.

Make sure that the seal fits properly.
• To avoid damages, only the Inspector Flex Dome accessory offered by SICK must be used.
• Minimize the risk of getting dust into the device by changing the lenses in a dust-free en-

vironment. Do not keep the device without the front window. Wipe off the front window
and the Inspector before you remove the front window.

19.2.2 Tilt device
Depending on the physical installation limitations and the nature of the application it's possible
to limit the reflections from the inspected material by tilting the device as compared to the
object.
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Slight tilt for glossy objects (recommended)Not recommended for glossy objects

Note
The tilt should be as little as possible but enough to be able to succeed with the configured
application. If the device is tilted too much then the perspective will be distorted. Due to this,
tilted device is not recommended when inspecting objects that has free rotation or small
objects that move a lot within the field of view. Calibration can compensate for tilting.

19.3 Calibrate image
The calibration function corrects perspective and lens distortion errors and provide an image
with improved geometrical precision. The calibration improves the robustness and the fine
positioning of the object locator, including the ability to find objects regardless of the position
in field of view. The precision of the inspection tools are also improved by the calibration. For
information on image calibration see Chapter 9, “Calibrate and align” (page 40)

19.4 Optimize contrast on multi colored targets
On the Inspector it is possible to replace the front window with a front glass filter accessory
in order to handle multicolored objects. Available filters are red, green, and blue. Refer to
the graph below for the transmission characteristics of the three different filters.
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The right edge of the red filter is limited by the internal IR-filter of the Inspector.
The color filters can be used both with internal and external illumination. Please note that
the transmission of the filters is only shown for single pass. For the internal lighting the
overall transmission is lower because of the double passing.
A special tool is required to open the front window of the Flex housing and to mount the color
filters. The tool is delivered in the Inspector Flex package.
The function of the color filters is to enhance that color and to suppress the opposing color,
according to the principle of opposing colors, see figure below.

Figure 19.2 Opposing colors

Below is an example of an image and the result of using different color filters:

Original photo in color
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Using red color filterStandard window - no color

Using blue color filterUsing green color filter

19.4.1 Mounting filters
To replace the front window with a front glass color filter:
1. Open the front window of the Flex housing using the large end of the supplied tool.
2. Attach the front glass color filter to the Flex housing by using the supplied tool.

19.5 Environmental conditions
Try to improve the quality and reduce the variations in the images captured by the Inspector
when inspecting.
• Shield out ambient light or use external lighting to reduce the variation in exposure caused

by the ambient light.
• If the objects will be moving at high speed, shorten the exposure time, to avoid motion blur

in the images. If this is difficult to do while maintaining a good image quality, consider
adding external lighting, see Section 8.3.2, “Use external lighting” (page 38).
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20 Improve robustness
If the Inspector PIM60 for example fails to locate correct objects or locates objects with de-
fects, there are a number of different ways to improve the accuracy/robustness of the locator
functions. The most important is to verify that the image quality is good enough, see
Chapter 19, “Improve image quality” (page 102). If this is fulfilled the next step is to adjust
the tool settings.

20.1 Object locator

Figure 20.1 Object locator settings

If the Inspector has problems locating objects correctly, try the following:

Fine-tune the learned contours
Change the Edge strength setting on the Object locator tab to adjust which contours that the In-
spector uses for locating. Also see Section 5.4.1, “Teach the reference object” (page 25)
and Section 2.1, “Verify dimensions and locate position of a known shaped object” (page 12).

Modify the size and shape of the object locator region
Try to remove contours that are not distinguishing for the object, for example contours in the
background. If there are no contours in the background, then it is good if the Object locator
region (blue) covers the object with a margin. Use rectangular or elliptical shape on the loc-
ator region to adapt to the type of object.
In general, the object locator will be more robust if as much as possible of the object is in-
cluded into object locator region. However, it is important that no disturbing edges from the
background, shadows, reflexes, etc is included in the object locator region. This can be
avoided by using the mask functionality. If the object is too small in the image, if possible try
to change the lens or move the inspector closer to the object.

Deselect Allow rotation if possible
Objects that are rotated more than the Allow rotation setting will not be located at all.

Restrict Allow objects anywhere in image if possible.
If the objects will always be located in a certain part of the image, restricting the search region
to this area will avoid having the Inspector mixing up contours outside or partially outside
this region from the correct ones.
Restrict the allowed region by deselecting Allow objects anywhere in image, and adjusting the
Search region (green rectangle) in the image.
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Deselect Allow scaled objects if possible
If the objects always appear at the same size as the reference object, deselecting Allow scaled
objects will avoid having the Inspector mixing up scaled contours from the correct ones.

Adjust search method

Figure 20.2 Advanced Object locator settings

Switch to a more robust search method for locating the objects, by changing the Search
method setting (under Advanced on the Tools tab). The Inspector's Searchmethod can be changed
using two sliders. One slider determines the trade-off between High robustness and High speed.
The other slider determines the trade-off between High accuracy and High speed.
The term High accuracy relates to which sub-pixel precision the object is located. For simple
applications it may not be necessary to find the optimal sub-pixel position of the object. A
fast coarse localization may then suffice. But for applications where the positioning of the
detailed inspections needs to be precise, this slider should be set to high accuracy.
The term High robustnessmeans that the object is located better in difficult images. This includes
images that for example contain much background clutter, heavy shadows, small objects,
low contrast, or much occlusion. For simple and clean scenes with large and high contrast
objects it is typically sufficient to run at the High speed mode.

20.2 Circle
If a circle tool has problems locating the circle correctly, try the following:

Adjust polarity and circle fit criteria
Adjust the settings for Circle fit criteria and Polarity to make the Inspector pick the right circle
if there are multiple circles in the region.

Adjust search method

Figure 20.3 Advanced Circle settings

Switch to a more robust search method for locating the objects, by changing the Search
method setting (under Advanced on the Tools tab). The Search method slider determines the
trade-off between High robustness and High speed.

20.3 Edge
If an edge tool has problems locating the edge correctly, try adjusting the settings for Criteria
and Polarity to make the Inspector pick the right edge if there are multiple edges in the region.

20.4 Edge counter
If an edge counter has problems locating the edges correctly, try the following:
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Adjust polarity
Adjust the settings for Polarity to make the Inspector pick the right edges in the region.

Adjust search method
Switch to a more robust search method for locating the objects, by changing the Search
method setting (under Advanced on the Tools tab). The Search method slider determines the
trade-off between High robustness and High speed.

20.5 Blob
If the Inspector has problems locating blobs correctly, try the following:

Modify the size and shape of the blob tool region
Try to remove areas which could include objects that are not to be defined as blobs. Use
rectangular or elliptical shape on the locator region to adapt search region's shape.

Mask out difficult areas
Areas that are known to vary between images, such as date codes or highly reflective areas,
should be ignored in the blob tool region. This is achieved by masking the area.

Adjust search method

Figure 20.4 Advanced Blob tool settings

Switch to a faster search method for locating the objects, by changing the Searchmethod setting
(under Advanced on the Tools tab). The Inspector's Searchmethod can be set with the slider that
determines the trade-off between High quality and High speed. Normally the High speed option
can be used on images where there is minor disturbance/noise in the image apart from the
blobs themselves and High quality should be used on images with more disturbance/noise.

20.5.1 Enable Ambient light compensation
The ambient light compensation can be used to handle variations in the surrounding (ambient)
light. The compensation is done by comparing the brightness in an area in the captured image
with the brightness in the corresponding area in the reference image, and then adjusting the
blob tool's Intensity thresholds accordingly.

Figure 20.5 The Intensity thresholds are adjusted for locating the objects in the Reference
image.
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Figure 20.6 Without ambient light compensation, objects may not be detected if the
ambient light changes a lot.

Figure 20.7 With ambient light compensation, the Intensity thresholds are adjusted so
that the objects are properly detected.

When placing the area to be used for ambient light compensation, note the following:
• The area should be placed somewhere within the Inspector's field of view where there are

no blobs during the inspection.
• Use masks to give the area a suitable shape.
• The compensation is improved if the area contains similar gray level as the blobs that

should be detected.
• If the reference object has multiple blob tools, the same area is used for compensation of

all blob tools.

20.6 Polygon
If there are problems to locate the polygon inspection, try the following:

Position search
Controls the extent of the rigid positioning. Avoid having values larger than approximately
half of the object side since the Inspector PIM60 may find other edges than the wanted.
However, the risk of finding other edges than wanted can be reduced if the polarity function-
ality is used (see below).

Flexibility search
Control the amount of flexibility. This parameter limits the distance between the rigidly fitted
corners and the flexibly fitted corners. If the object has a solid shape and it is only moved or
rotated the value of Flexibility search should be low. A value of 0 means that no flexibility is
allowed. It is not optimal to set a low value since it is difficult to draw the exact polygon for
the object. Set a value of 3-4 for example to have a margin of error. Do not set the flexibility
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search too high, since this will increase the risk of finding other edges than wanted. See fol-
lowing figure. See also Section 10.9, “Polygon (not included in PIM60 Bead P/N 1076617,
1079321, 1079322) ” (page 64).

Object found, Flexibility search 12.Object not found, Flexibility search 0.

Figure 20.8 Flexibility search

Note
High image quality is needed for the polygon tool to work. Edges with high intensity are pre-
ferred over edges close to the defined polygon.

Polarity
If possible, use a specific polarity. This significantly decreases the risk of finding other edges
than wanted. For the case when the object borders can both be darker or brighter than the
background, the “Any polarity” mode needs to be chosen. Try to avoid these situations by
improving the lighting setup, for example using a backlight.

20.7 Pattern, Pixel counter, Edge pixel counter
If the Inspector has problems correctly inspecting details on objects, try the following:

Adjust inspection settings
Try the following method to find proper settings for a detailed inspection:
1. Have the Inspector inspecting a number of acceptable objects, and make note of the

results for the detailed inspection.
2. Do the same thing, using faulty objects instead, and note the result.
3. Set the No. of pixels in range, No. of edge pixels or Match setting so that the thresholds are

halfway between the results for the acceptable and the faulty objects.
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Modify the inspection regions
You can change the regions in the image on the Reference image tab:
• Move, resize and rotate an inspection region with the handles that appear on the region

when selected.
• Change the shape of a region with the Change region buttons on the Tools tab.
• Mask out areas of the region with the Mask tool.

Note
After modifying a Pixel counter or an Edge pixel counter, you may have to adjust the setting
for No. of pixels in range or No. of edge pixels on the Tools tab.
Stable intensity is needed for robust pixel countings

Choose a different type of detailed inspection
Sometimes it may help to try a different inspection type. For example, using an Edge pixel
counter instead of a Pixel counter may make the inspection more tolerant of ambient light.

Divide a detailed inspection into several smaller inspections
Sometimes one defect may even out another defect in an inspected region, for example ink
smudges may compensate for missing print in a printed date. Using several smaller detailed
inspections that cover the same area on the object can reduce the risk for this to happen.

20.8 Replace reference image
Getting good images is often critical for correct inspections. To replace the reference image:
1. Place a good object in front of the Inspector.
2. Switch to Edit mode, and adjust the exposure and gain on the Image settings tab.
3. Click Replace reference imagebelow the image on the Live image tab. The Inspector captures

a new image of the object and displays it on the Reference image tab.
4. If necessary, adjust the regions in the reference image so that they are located at the

correct positions on the object.

Note
To better handle variations in the orientation of the objects, choose a reference object that
has an orientation which most closely matches the orientation of the objects to be inspected.
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21 Improve speed
There are a number of ways to improve the inspection speed if it is not fast enough. Parameter
settings that can be used to improve speed are listed below. When testing these improve-
ments, observe the frame rate shown below the image. Speed optimization is a trade-off
between speed and robustness or speed and available interfaces.

Image settings
• Reduce exposure time.
• Decrease image size.
• Remove calibration

Object locator
• Decrease size or remove the Object locator region, in reference image.
• Reduce or deselect rotation.
• Reduce search region by deselecting Allow objects anywhere in image.
• Deselect Allow scaled objects.
• Adjust Search method to high speed under Advanced settings.

Circle
• Avoid selecting Circle with search region under Advanced settings.
• If search region is enabled, increase minimum diameter.
• Adjust Search method to high speed under Advanced settings.
• Reduce the distance between the diameters in Min / max diameter.

Edge
• Reduce the size of the tool's region.

Edge counter
• Adjust Search method to high speed under Advanced settings.
• Reduce the size of the tool's region.

Blob
• Reduce the size of the search region.
• Adjust Search method to high speed under Advanced settings.

Pattern
• Decrease Position tolerance.
• Use Pixel counter tool if Pattern is not needed.

Polygon
• Decrease Position search.
• Decrease Flexibility search.

Pixel counter, Edge pixel counter, Distance, Angle
• Fastest tools, can not be optimized.

Interfaces and I/O settings
• Deselect I/O extension box.
• Deselect EtherNet/IP.
• Deselect Web Server.
• Deselect Store images to FTP.
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22 Log and store images

22.1 Use image log
The Inspector PIM60 saves up to 30 images in its memory. To view the logged images, click
on the Logged images tab. To be able to log images at least one reference object has to be
configured.

Note
The image log will not be displayed in SOPAS Engineering Tool (ET) while the Inspector
PIM60 is storing images to FTP.

Log settings
To change which images the Inspector PIM60 should log, choose Log settings from the Inspect-
orPIM60 menu. You can choose the following alternatives:
All Every captured image.
Passed Images where the object was located and all detailed

inspections passed.
Located All images where an object was located, regardless of

whether any detailed inspection passed or failed.
Detail failed Only images where one or more detailed inspection

failed.
Failed (Not located or Detail failed) Images where either no object was located, or where

one or more detailed inspections failed.

Save logged images to PC
To save the log to the PC - all images and the results from the inspection - click Save log.
The log is saved as an HTML file (LogReport.html) that can be viewed in any web browser. The
images are saved in two folders together with the HTML file, one folder that contains the
images without graphical feedback, and one folder that contains the same images but with
the graphical feedback.
The images without graphical feedback can be used in the simulated device.

Update the image log
Images that the Inspector PIM60 adds to the log are not automatically added to the list on
the Logged images tab. To update the displayed list of images with images added by the In-
spector, click Update log.
When updating the log, the oldest images are removed from the list, keeping the maximum
number of images at 30.

Clear the Image log
To remove all images from the image log, click on the Clear log button. The images are also
removed from the Inspector PIM60.

22.2 Store images on a FTP server
The Inspector PIM60 can store logged images on a FTP server, which enables the user to
review the images.

Setting up
To make the Inspector PIM60 store logged images to an FTP server, do the following:
1. Choose Store Images to FTP from the Inspector PIM60 menu.
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2. In the dialog box, select the Store images tab and enter the following:
• Check Enable FTP storage of logged images.
• Choose whether to automatically start storing images to FTP when in Run mode.

3. Select the FTP settings tab and enter the following information:
• The IP address of the FTP server.
• A user name and password for connecting to the FTP server.
• The path to the folder in which the images should be stored. This folder will be created

on the FTP server if it does not already exist.

4. Click Test connection to test the connection to the FTP server. The Inspector will try to log
in to the FTP server.

Note
The Test connection function only tests the connection to the FTP server, it does not test the
possibility to read/write files and folders.

Note
The selection criteria for store images to FTP is the same as image log.

Warn for unsent images
When the Inspector PIM60 is storing images to FTP it can queue up to 30 images in case
that it should not be able to store images as fast as it is inspecting.
To make the Inspector PIM60 signal on a digital output if the queue is getting full, select Warn
for unsent images and choose which digital output to use for the warning. When used, the
warning will be mapped to the same output regardless of which reference object is currently
used. The Inspector PIM60 will warn if there are more than 20 unsent images. The warning
will be reset when there are less than 10 images in queue.
If the queue of unsent images becomes full, for instance if the FTP server is down, the oldest
image in the queue will be replaced with the new image.

Using the stored images
The images are stored on the FTP server as Windows bitmap files (BMP). The files are named
in the following way:

<Reference object>_<inspection ID>_<result>.bmp

For example: Aloe_00000147_pass.bmp
Note that only the captured images will be saved, without any detailed result. To get the in-
spection result you can do the following:
1. Let an external device (for example a PLC) read the inspection results via EtherNet/IP

and store the results. Use the inspection ID to combine the stored image with the inspec-
tion result.

2. Use SOPAS Engineering Tool (ET) with a simulated device, and let the simulated device
inspect the stored images. This way you can also get images with the inspections drawn
in them, or use the images to adjust the configuration to make the inspections more ro-
bust.
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Note
The simulated device uses the same algorithms as the real Inspector, and for most configur-
ation they will produce identical results. However, in some situations there may be minor
differences, due to the different hardware in the Inspector and the PC. To minimize the impact
of any such differences:
• Always make final verification of your configuration using a real Inspector.
• Make sure that there is a large enough tolerance in the pass/fail criteria to allow for minor

differences.

Note
Activating the function Store images to FTP may have impact on the live image rate for other
interfaces, for example the live image in SOPAS Engineering Tool (ET).

22.3 Record live images to PC
To record images captured by the Inspector as files on the PC, choose Record Live Images from
the InspectorPIM60 menu.
After selecting a folder in which to save the images, a dialog box is displayed in which the
number of recorded images is displayed.
To stop recording images, click Stop recording in the dialog box.
The images will be saved as separate files in the folder you selected. The images are saved
in 8-bit gray scale BMP format.

Note
This saves only the images that are displayed in the Live image in the PC application, which
is not necessarily every image that the Inspector PIM60 captures.
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23 Use the simulated device
SOPAS Engineering Tool (ET) has a simulated device which can be used to simulate and test
device settings off-line without access to a real Inspector. The simulated device can be used
for evaluating inspection settings by using previously saved images. Image capturing and
external communication interfaces are not available in the simulated device.

Note
The simulated device uses the same algorithms as the real Inspector, and for most configur-
ation they will produce identical results. However, in some situations there may be minor
differences, due to the different hardware in the Inspector and the PC. To minimize the impact
of any such differences:
• Always make final verification of your configuration using a real Inspector.
• Make sure that there is a large enough tolerance in the pass/fail criteria to allow for minor

differences.

23.1 Start the simulated device
There are two ways to start the simulated device:
• Starting the simulated device when already connected to an Inspector
• Starting the simulated device when starting SOPAS Engineering Tool (ET)

23.1.1 When connected to an Inspector
To start the simulated device when connected to an Inspector, select Switch toSimulatedDevice
from the Device menu.

23.1.2 From SOPAS Engineering Tool (ET)
See the SOPAS ET Manual (available from the Help menu in SOPAS Engineering Tool (ET) main
window) for instructions.

23.2 Control the simulated device
The buttons in the bottom of the Live image tab controls the simulated device. These controls
are only visible when using the simulated device. The buttons are:

Run, loops over the images in the selected folder.

Pause, pauses on the current image.

Next image, steps to the next image and pauses.

Previous image, steps to the previous image and pauses.

Repeat, deselect to run through the images once.

23.3 Select images to be used
To use saved images with the simulated device, the images must be in bitmap (.BMP) file
format (8 bit gray scale). In order to retrieve images to PC, see Chapter 22, “Log and store
images” (page 115). If the resolution does not match the selected FOV:
• Large images will be truncated and the centered part of the image will be used.
• Small images will be centered in the field of view and filled with black outside the image.
To select image source folder used by the simulated device:
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1. Click Select images.
2. Select the image folder. Click Open. The folder path is displayed under the Select images

button.
The selected images is shown in alphanumeric order with the numeric order first.

23.4 Copy device data from the simulated device to an Inspector
If you have used the menu option Switch to Simulated Device, then you can copy device data
from the simulated device to an Inspector, by selecting Switch to Physical Device from the Com-
munication menu.
If the simulated device was started via the Emulator tab, then you can copy device data by:
1. In the simulated device, select Save Device File from the Project menu.
2. Connect to an Inspector, see Chapter 6 "Connect".
3. Load device data to device, see Section 24.4, “Copying device data from one Inspector

to another” (page 121).
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24 Handle device data
The device data are all settings used to configure and control an Inspector. The device data
consists of:
• Reference images
• Image capturing settings
• Object locator and inspection tool settings
• Output settings
• Interface configuration settings
• Calibration and alignment configuration (device-unique)
The image log and statistics are not included in the device data.
The device data can be stored permanently in the device flash memory to let the Inspector
work independently from the configuration interfaces. The device data can also be extracted
from the device for backup or transfer to other devices.

24.1 Save device data on the Inspector (in flash memory)
To save all device data (settings) in the Inspector's flash memory, select Save Settings in Flash
from the InspectorPIM60 menu. A progress bar is displayed during the process. The Inspector
will stop inspecting until the flash memory is updated. When saving to flash memory the
function LED will flash white.
If the settings are changed in SOPAS Engineering Tool (ET) Edit mode, the user will be
prompted to save to flash memory when switching to Run mode.
Please note that it may take several minutes to save the settings in flash memory. The more
configured reference objects, the longer time it takes.
Settings that are saved in the Inspector's flash memory will be used when the Inspector starts
again after a power loss. If you do not save the settings in the flash memory, the changes
made will be lost if the power is disconnected.

24.2 Save device data on PC
Choosing Save Device File as from the File menu will save the Inspector's current device data
to a new file (.sdv) on the PC, and the file can be opened in SOPAS Engineering Tool (ET).
The file will contain all device data including the reference images and a reference to the
Inspector used.
The device data saved with SOPAS Engineering Tool (ET) can not directly be imported by an
Inspector through the Web API interface. To use a configuration created in SOPAS through
the web interface, you must instead export the configuration as an .spb file. Export the
configuration by clicking Edit→Export SOPAS Parameter backup. See the reference manual for
Inspector PIM60 for more information.

24.3 Use saved device data on the Inspector
To use saved device data, choose OpenDevice File from the File menu and select the file (.sdv).
When opening a saved file, the PC application will try to connect to the Inspector for which
the file was saved.
If you have unsaved changes in the Inspector, you will be asked if you want to save these
before continuing.
If the Inspector, for which the file is saved, is found, then you can start using it.
If the Inspector is found but the device data differ between the Inspector and the file, then
you are asked if you want to use the device data in the Inspector or from the file.
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If the Inspector is not found, set up a connection with an Inspector and download the saved
device data (see Section 24.4, “Copying device data from one Inspector to another” (page 121)).

24.4 Copying device data from one Inspector to another

Warning
It is not possible to run a configuration made using Inspector PIM60 V 1.0 firmware on an
Inspector PIM60 with V 2.0 firmware (or vice versa). The present configuration needs to be
redone. See Section 6.3, “Upgrade or downgrade the firmware” (page 31) for more informa-
tion.

To copy device data from one Inspector (source) to another Inspector (destination):
1. Connect to the source Inspector.
2. Save the device file, choosing Save Device File as from the File menu.
3. Connect to the destination Inspector.
4. Download the device data to the destination Inspector with the Load Device Data to Device

Wizard.
a. Choose LoadDeviceData toDevice from the Edit menu. Click Browse to browse for device

files.
b. Select the device file and click Open.
c. The device data is transferred to the Inspector. Click Finish.

24.5 Export and import device data through web server or Web API
It is possible to export the device data through the Web interface as well as the Web Server.
For more information on how to do this through the Web see commands section in the Ref-
erence manual for Inspector PIM60.
The device data exported through the web interface can be imported again by an Inspector
through the web, or imported in SOPAS Engineering Tool (ET).

24.6 Restore settings to factory default
It is possible to return to the factory settings. All device data will be deleted. To restore settings:
1. Select RestoreSettings from the InspectorPIM60menu and click on Factory defaults. A warning

dialog box is displayed.
2. Click Yes to restore settings to factory settings. Or click No to cancel.

Note
The IP address of the Inspector will not be reset when restoring the settings.
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A Technical data

A.1 Dimensional drawings
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A.2 Inspector connectors

Inspector PIM60
Ethernet - 10/100 Mbit/s

21

34

Inspector connector pinning – Ethernet/X1/X2, 4 pin, M12

Signal descriptionSignalPin

Transmit +Tx+1

Receive +Rx+2

Transmit –Tx-3

Receive –Rx-4

Inspector PIM60
Ethernet - 10/100 Mbit/s

2

10

1

9

8

12

3

4

11

5

6

7

Inspector connector pinning – Power In/Out, 12 pin, M12 connector

Signal descriptionSignalColoraPin

24 V power supplyPowerBrown1

Ground 0 VGNDBlue2

Image trigger + External object selection
(24 V)

In3White3

Output 1 – Object not located (B-type)bOut1Green4

External teach + External object selection
(24 V)

In2Pink5

Output 2 – Inspection failed (B-type)bOut2Yellow6
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Inspector connector pinning – Power In/Out, 12 pin, M12 connector

Signal descriptionSignalColoraPin

Output 3 – All pass (B-type)bOut3Black7

External object selection (24 V)In1Gray8

External trigger, external illumination,Ext triggerRed9
(5 C TTL)

Encoder + External object selectionIn4Violet10
(24 V)

ReservedGray/pink11

ReservedRed/blue12
aColors are valid for cable type DOL-1212.
bPush-pull output.

A.3 LED description

Inspector PIM60

Inspector – LED description

DescriptionColorModeLED

Ethernet DataYellowAllData

Ethernet LinkGreenAllLink

Not locatedBlueRun/EditFunction

Detailed failedRed

All passedGreen

No inspectionOff

Device data is stored in flash memoryWhite

Image focus. Higher frequency means better
focus.

FlashingExternal teach

No motion in field of viewGreen

Motion in field of viewBlue

Device data is stored in flash memoryWhite

Fatal errorRed, slow flashingAnytime

Power OnGreenAllOn
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A.4 Technical specification

VSPM-
6B2413

PIM60-IR
Base

VSPM-
6F2413

PIM60-IR

VSPM-
6F2313
PIM60-

LUT

VSPM-
6B2113
PIM60
Base

VSPM-
6F2113
PIM60

50 … ∞ mmWorking distance

50 … 200 mm- Internal illumination

22 x 15 … 79 x 58 mm2Field of view, internal illumina-
tion

ExchangeableOptics

No lens10 mm10 mmNo lens10 mmFactory mounted lens

200 fpsMax performance

40 fpsTypical performance

Repeatability, position a

± 0.2 pixels- Object locator

± 0.1 pixels- Blob

± 0.05 pixels b- Edge

± 0.5 pixels- Find maximum

± 0.05 pixels b- Circle

Repeatability, anglea

± 0.05º- Object locator

± 0.02º- Blob

± 0.02º- Angle

Object locatorToolset
Blob, Pixel counter, Edge pixel counter, Polygon, Pattern
Circle, Edge, Find maximum, Edge counter, Distance,
Angle

Perspective and lens distortion, mm resultsCalibration
Result alignment to external coordinate system

64 tools, of which max 8 Polygon, max 8 Blob, and max
4 Edge counter

Number of tools

32 objectsReference images

Simulated deviceOffline support

Production control

SOPAS- Operator interface
Web Server, import of customized pages

30 images device log- Data store and retrieve
Record images on PC
Store images to FTP

EtherNet/IP- Ethernet communication
Ethernet Raw configurable
Web API

5 inputs for object selection- I/O Extension box

8015728/2018-10©SICK AG • Identification & Measuring • www.sick.com • All rights reserved
Subject to change without notice

126

Operating InstructionsTechnical dataAppendix
Inspector PIM



VSPM-
6B2413

PIM60-IR
Base

VSPM-
6F2413

PIM60-IR

VSPM-
6F2313
PIM60-

LUT

VSPM-
6B2113
PIM60
Base

VSPM-
6F2113
PIM60

16 outputs

640x480 pixelsResolution

IR ring light, 850 nmUV ring
light, 385

nm

White ring lightLight source

Risk group 0 (low risk)Risk group
1 (low
risk)

Risk group 1 (low risk)- LED class (IEC62471:2006)

Approx. 370 nm ...
900 nm

Approx.
400 nm …
750 nm

Approx. 400 nm …
750 nm

Spectral response

24 VDC ±20%Supply voltage

< 5 Vpp- Ripple

< 450 mA, without load- Current consumption

3 outputs 24 V (B-type)cDigital outputs

100 mA- Output current

Not located, detail failed, all passed- Default outputs

Output by logical expressions- Configurable outputs
Store images to FTP overflow

5 V TTLControl of external light

4 inputs 24 VDigital inputs

External trigger, encoder, external teach, reference object
selection

- Configurable inputs

40 kHz- Max encoder frequency

100 Mb EthernetInterface

Operation: 0 °C … 45 °CAmbient temperatured

Storage: -20 °C … 70 °C

AluminumHousing material

No windowPMMA
(plastic)

GlassNo win-
dow

PMMA
(plastic)

- Window material

350 gWeight

IP 20eIP 67IP 67IP 20eIP 67Enclosure rating

EN 60068-2-27Mechanical shock load

EN 60068-2-6Vibration load

Device specific accessoriesf

Focal length: 6 mm, 8 mm, 10 mm, 16 mm- Lenses, focal length

PMMA (plastic), Glass- Transparent front windows

Red (> 588 nm)–Red (> 588 nm)- Front filtersg

Visible block filterGreen (544 ± 53 nm)
Blue (468 ± 62 nm)
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VSPM-
6B2413

PIM60-IR
Base

VSPM-
6F2413

PIM60-IR

VSPM-
6F2313
PIM60-

LUT

VSPM-
6B2113
PIM60
Base

VSPM-
6F2113
PIM60

Optimal for 50 mm
working distance

–Optimal for 50 mm
working distance

- Dome

4 inputs, 8 outputs- I/O extension box

2 extra digital inputs- I/O module
8 extra digital outputs

aStatic object
bAlso valid for distances between the positions.
cPush-pull output.
dRel. Humidity: 35 … 85%, 95% at storage.
eIP 67 is secured after correct assembly of lens and front window.
fFull accessory list at www.sick.com.
g> 60% transmission.

Most of the specifications in the table above are valid also for the PIM60 Bead variants, but
there are some differences. They are listed in the table below.

VSPM-6F2413S18
PIM60-IR Bead

VSPM-6F2313S20
PIM60-LUT Bead

VSPM-6F2113S19
PIM60 Bead

IR ring light, 850 nmUV ring light, 385 nmWhite ring lightLight source

Object locatorToolset
Blob, Pixel counter, Edge pixel counter, Bead, Pattern
Circle, Edge, Find maximum, Edge counter, Distance, Angle

32 tools, of which max 8 Bead, max 8 Blob, and max 4 Edge counterNumber of tools

Production control

20 images device log- Data store and re-
trieve Record images on PC

Store images to FTP

A.5 Accessories ordering information

Order no.Type

2045167Inspector angle bracket

2045397Inspector light/filter adapter

1048400Inspector Universal arm + adapter bracket

2049668Lens focal length 6 mm

2056692Lens focal length 8 mm

2049415Lens focal length 10 mm

2049418Lens focal length 16 mm
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Order no.Type

2050675Inspector Flex Color filter, red

2050677Inspector Flex Color filter, green

2050676Inspector Flex Color filter, blue

2061248Inspector Flex Visible block filter (PMMA)

2050678Inspector Flex Dome

6037654I/O extension box (4 inputs, 8 outputs)

6039038I/O module, 2 extra digital inputs

6037750I/O module, 8 extra digital outputs

2052266Front window, Inspector flex (glass)

2050690Front window, Inspector flex (PMMA)

2050703Tool, front window Inspector flex

2066933Distance ring package (package of 3 pcs of 1,5 mm rings)

For a complete list of accessories for the Inspector, including cabling and external lightings,
please visit www.sick.com.

A.6 What's included – Inspector PIM60
The boxed version of the Inspector PIM60 includes:
• Inspector PIM60
• Printed Quickstart
• 2 mm hex key
• Tool for exchange of lens
• Two focused stickers
Languages: English, French, Italian, German, Spanish, and Chinese (simplified).1

A.7 System requirements
• Windows XP Professional (Service Pack 2) or Windows Vista Business Edition service pack

1 (32/64 bit) or Windows 7 Professional (32/64 bit)
• Pentium 4 3.0GHz
• Windows XP: 512 MB of RAM (Recommended 1024 MB)

Windows Vista: 1 GB of RAM
Windows 7: 1 GB RAM (32-bit) or 2 GB RAM (64-bit)

• 1024 x 768 or higher screen resolution, minimum 256 colors (recommended 65536 colors)
• 570 MB free hard disk space
• Ethernet: 100MBit/s recommended

1The reference manual is only available in English.
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B Support

B.1 Technical support

B.1.1 Preparing for technical support
To increase effectiveness and speed up technical support issues it is good to find out the
following before contacting support;
• Find out the SOPAS Version and Build number (SOPAS GUI: Help→Info)
• Find out the Product model, Application-, FPGA- and Monitor version (SOPAS GUI: Help→About
Inspector)

• Save a device file that can be sent to support;
– If using SOPAS Engineering Tool (ET), Project→Export Device

• Save a system dump file that can be sent to support (SOPAS GUI: InspectorPIM60→Device
Info→Save system dump)

• If possible, please also provide PASS/FAIL images (InspectorPIM60→Record Live Images, or
logged images with/without graphics)

B.1.2 Web support
Technical support is available on-line at;
www.sick.com →Service&Support→Support→Support for Vision

B.1.3 First line support
Technical support is available to all users of the SICK Vision Technology. All 1st line technical
support should always go to your local SICK subsidiary first hand. Below are contact inform-
ation to dedicated 1st line support in USA, Canada and Germany. For the rest of the world,
please contact your local SICK Subsidiary and ask for their vision specialist.

GermanyUSA, Canada

bildverarbeitung@sick.devisionhelp@sick.com

B.2 Further information
More product and order information is also available on: www.sick.com.
Please see the online help in SOPAS for Inspector.
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Glossary
Ambient light compensation Function using the light intensity measurement in a specific area of the image to com-

pensate for increase or decrease in overall light intensity compared to the reference
image. This can be used to compensate threshold settings for tools sensitive to variations
in the overall light intensity.

Angle The term angle is used for the following:
• For blobs, the rotation angle of each located blob is calculated, and is available in the

Results tab and as Ethernet output.
• For angle measurements, the angle between two located edges is calculated, and is

available in the Results tab and as Ethernet output.
The term rotation is used together with the object locator.

Background Everything in the image that is not the object(s) that the Inspector is configured to locate.

Blob An object with a free-form shape. A blob is found in the image if it lies within specified
intensity and size ranges.

Blob tool The tool used to locate free-form shapes in the image.

Calibration Procedure to measure lens and perspective distortion to calculate a transformation used
to correct for these errors.

Capture image To take an image. A captured image can either be used for object positioning or inspection
in the live image or be used as a reference object in the reference image.

Center of gravity (COG) The center of gravity for all found blobs are visualized in the SOPAS Engineering Tool
(ET) GUI and can be reported via Ethernet.

Chessboard pattern Black and white square pattern used by the Inspector to measure lens and perspective
distortion.

Color filter An accessory that replaces the front window with a color filter front window to enhance
contrast of certain color combinations. Red, green, and blue filters are available.

Contour Another word for edge. The contours that the object locator finds on an object are marked
green. The amount of contours is adjusted by the edge strength parameter.

Contrast The difference in gray levels between dark and bright areas in the image.

Deployment Activities performed to install a device. Includes fitting the correct lens, mounting, focus
adjustment and loading of device data.

Device data The device data are all settings used to configure and control an Inspector, for example
reference images, tool settings and interface settings.

Device file A file that contains device data of a specific Inspector. File extension is .sdv.

Dome accessory An Inspector Flex accessory that replaces the front window of the Inspector Flex. The
Dome diffuses the internal lighting in order to be able to work with glossy (shiny) objects.

Edge The line that is formed between a dark and a bright area in the image.

Edge contrast The minimum difference in intensity (gray scale values) between neighboring bright and
dark areas that is required for the circle tool and edge tool to consider it an edge (con-
tour).
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Edge strength The minimum difference in intensity (gray scale values) between neighboring bright and
dark areas that is required for the object locator to consider it an edge (contour).
The minimum difference in intensity (gray scale values) between neighboring bright and
dark pixels that is required for the edge pixel counter, and the structure measurement
in the blob tool, to consider it an edge pixel.

Field of view (FOV) The area which is currently seen by the Inspector, for example defined by its width and
height in mm. The size depends on the working distance and the lens’ focal length.

Flexible fitting Flexible fitting is used by the polygon tool to get the best fit of the if each polygon segment
without keeping the original polygon shape as drawn in the reference image.

Focal length The aspect of a lens that determines how large the field of view becomes at a given
working distance. If the focal length is short, for example 6 mm, then the lens has a wide
angle and sees a large scene. If the focal length is long, for instance 16 mm, then the
lens has a narrow view angle (tele lens) and sees a small scene far away.

FOV (field of view) See field of view

Free-form object/shape An object whose shape is not defined, also referred to as blob. The object is distinguished
from the background depending on its gray values and size (pixel area).

Free-running The image capture mode where images are captured and analyzed as fast as is possible,
all done at a constant rate.

FTP File Transfer Protocol. Standardized communication protocol.

Gray level Another word for intensity. In Inspector, intensity values range from 0 (black) to 255
(white). Any value in between 0 and 255 is a gray level.

Image log See Logged image.

Image settings The parameters that control:
The quality of the captured images (exposure, brightness, use of lighting).•

• When to capture images (free-running or triggered).

Image size The size of the image captured by the Inspector, measured in pixels (width x height).

Intensity See gray level.

Live image A captured image that is inspected by the Inspector.

Locate This is what the Inspector does to identify and find the position of the object in a captured
image. Either of the methods object locator or blob tool can be used.

Log settings The criteria for saving images in the image log.

Logged image A captured image that is saved in the image log in the Inspector. The image log can
contain up to 30 images.

Mask A part of a region that shall be excluded from the image analysis. The mask can be used
to exclude areas in the object locator search region or to avoid finding blobs in chosen
areas of the blob tool search region.

Match The required similarity between the object in the image and the reference object.

Match settings Settings that affect when an object is considered located, for example similarity and
rotation tolerance.

Object What the Inspector shall locate and inspect.
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Object locator The tool used to locate an object of known shape in the image.

Pick point A predefined point on the object, for example to be used as pick point in a robot picking
application. Pick point terminology is used in robot applications, and it has the same
meaning as reference point.

Polarity Polarity is used by the polygon tool to increase the robustness of the edge fitting by not
only searching for the strongest edge, but to also separate between dark-to-bright and
bright-to-dark edges. This will reduce the risk of finding the wrong edge.

Polygon A geometrical shape formed by a set of line segments connected to each other at the
end of each line segment. A polygon can be open or closed.

Positioning Finding the location of an object and reporting the object's reference point.

Rectification The process to use the calibration information to transform an image captured by the
image sensor, into an image greatly reducing lens and perspective distortion.

Reference image The reference image is the pre-taught image of the reference object.

Reference object An object that the Inspector has learned to locate. It includes the reference image, tools
and result settings.

Reference point A particular point on the object, for example to be used as pick point in a robot picking
application. The default for the object locator and the pattern tool is the center of the
region. The default for the blob tool is the center of gravity of the blob.

Region An area of the image that is used for the object locator or a tool.

Rigid positioning Rigid positioning is used by the polygon tool to get the best fit of the whole polygon
keeping the original polygon shape as drawn in the reference image.

ROI Region of interest.

Rotation The term rotation is used together with the object locator. The rotation of a located object
relative the taught object is calculated and is available in the Results tab and as Ethernet
output. The term angle is used together with the blob tool.

Search region The region in the captured image in which the Inspector will try to locate the object, the
blobs, or the circle. For the object locator the default region is the whole field of view.
For the blob tool and circle tool, the search region is drawn by the user at the time of
creation. The Search region can be changed in the Reference image tab.

SOPAS SICK Open Portal for Applications and Systems. User interface for configuration of SICK
products and systems.

Stand-off Distance between the lens cover glass and the object.

Structure Surface characteristic of a blob, for example spots or large reflections inside a blob. The
structure can be used to separate one object type from another. Structure corresponds
to the number of edge pixels found inside a blob and it can be used as a selection criteria
for the Blob tool, for example filtering out blobs with certain surface characteristics.

Target Another word for object.

Teach What the user does to make the Inspector learn a new reference object.

Threshold Another word for a limit that defines what is inside or outside a range. When there is
sufficient contrast in an image, a well fitted threshold value can separate objects from
the background.
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Tool A method or algorithm to accomplish an image analysis task, for example locating an
object in an image.

Toolbox A set of image processing algorithms used to find important information in the image.

Triggered The image capture mode when images are taken on an external command, for example
when a photoelectric switch goes high.

Web API HTTP based interface mainly intended for integration with custom made HMI systems.

Web Server Web interfaces giving access to a set of inspector functions from a standard web browser.

Working distance The distance between the lens and the object, see field of view.
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Index
A
Accessories

ordering information, 128
Active time, 39

Fixed, 90
Hold until result changes, 90

Adjust
Exposure, 37
Focus, 24, 37
Gain, 38
Image settings, 37
Image size/field of view, 39

Align, 40
Ambient light compensation, 110
Angle, 75

Blob, 58
Measure, 73

Angle tool, 73

B
Bead tool, 68
Blob tool

Ambient light compensation, 110
Angle, 58, 75
Blob structure, 61
Blob tool result example, 62
Improve robustness, 110
Tools, 58

Brackets, 123

C
Calibrate, 40
Change lens, 102
Circle tool, 49
Color filter, 105, 128
Configure device interface, 30
Connect, 30

Change IP address, 30
From SOPAS, 23
Hardware, 23
Troubleshooting, 30

Connection wizard, 23
Connections, 17
Connectors, 124
Coordinates

x, y, 29
Copy device data, 119

D
Default password, 35
Defect detection

Polygon, 67
Device catalog, 31

Digital I/O, 83
Dimensional Drawings, 123
Distance tool, 71
Dome, 104, 128

E
Edge counter, 56
Edge Pixel Counter

Inspection, 71
Edge Pixel Counter Tool, 71
Edge tools

Edge, 52
Find maximum, 54

Edit mode, 33
Encoder, 86, 124
Environmental conditions, 107
Ethernet Raw, 94
EtherNet/IP, 92
Exposure, 37
External lighting, 38
External object selection, 86
External teach, 84

F
Field of view (FOV), 39
Find maximum, 54
Firmware

Downgrade, 31
Upgrade, 31

Focus, 24
Adjust, 37

Focus feedback bar, 24
Frame rate, 33

G
Gain, 38

H
Hex key, 22, 24, 37
Hide contours, 33
How to

Align, 40
Calibrate, 40
Connect, 30
Connect an encoder, 86
Connect an image trigger, 85
Connect from SOPAS, 23
Connect the hardware, 23
Copy device data, 121
Handle device data, 120
Improve speed, 114
Locate objects, 45
Restore a device, 121
Select reference object with inputs, 86
Use external teach, 84
Use saved device data, 120
Use statistics, 77
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View results, 75

I
Image capturing modes

Triggered mode, 85
Image coordinates, 33
Image settings, 37

Exposure, 37
Focus feedback bar, 24
Gain, 38
Image sieze/field of view, 39

Image size, 39
Improve, 112

Blob tool robustness, 110
Color filtering, 105
Image quality, 102
Object locating, 45
Object locating robustness, 108
Polygon locating robustness, 111
Reflex avoidance, 104

Inspection Robustness
Improve robustness, 112

Inspector Firmware Download Manager, 31
InspectorPIM60 menu, 34

Device info, 35
Edit, 34
Ethernet result output, 35
I/O settings, 34
Interfaces, 34
Log settings, 35
Record live images, 34
Restore settings, 36
Save settings in flash memory, 35
Set password, 35

Install SOPAS Engineering (ET), 22
Interfaces, 81
Internal lighting, 38, 126
Invert output signals, 90

L
LED, 38, 125

Class, 126
Lens, 102, 128
Lighting, 38

External, 38
Internal, 38, 126

Live image tab, 33
Locate, 45

Circle, 49
Edge, 52
Find maximum, 54
Free-form shape, 58
Known shape, 47
Polygon, 64

Log settings, 35

M
Main view, 33
Measure

Angle, 73
Distance, 71

Measurement
Distance, 13
Verify, 12

Minimum delay time, 33, 89
Minimum FOV, 39

N
Number of ignored trigger pulses, 33

O
Object locator

Edge contrast, 26
Fine tune learned contours, 108
Improve robustness, 108
Reference point, 27
Region, 26
Rotation, 75
Tab, 47

Offset compensation
Angle, 74
Distance, 73

Operating modes
Edit mode, 33
Run mode, 33

Optimize FOV, 102
Ordering information, 128
Output results, 87
Output settings

Active time, 87
Delay, 87
Hold until result changes, 90
Invert, 87
Minimum delay time, 33

P
Password, 35
Pattern

Inspection, 63
Pattern Tool, 63
Pixel Counter, 70
Polygon

Inspect polygon edges, 13
Polygon corners, 13
Polygon tool, 64

Improve robustness, 111
Positioning

Known shape, 12-13

Q
Quick start, 22
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R
Reference Image

Replace Reference Image, 113
Reference object, 25

Duplicate, 80
Global settings, 80
Select in SOPAS, 79
Settings, 80
Teach additional, 79

Resize image, 39
Restore settings, 36, 121
Results, 75, 87
Run mode, 33

S
Save

Device data on PC, 120
Device data on the Inspector (in flash memory), 120
Settings in flash memory, 35
System dump, 35

SDD, 31
Set

Output active time, 90
Output delay, 89
Password, 35

Show contours, 33
Simulated device

Control, 118
Copy device data, 119
Select images, 118
Start, 118

SOPAS
SOPAS Engineering Tool (ET), 32

SOPAS Device Driver, 31
SOPAS Engineering Tool (ET), 22, 32
Supply voltage, 126
Support

First line, 130
Web, 130

System dump, 35
System requirements, 129

T
Teach object, 25
Temperature

Ambient, 126
Storage, 126

Toolbox, 18, 45

V
Valid FOV, 39

W
Web interface, 97
What's included, 22, 129
Working distance, 126

Dome, 104
Internal lighting, 126
Lenses, 102

Z
Zoom, 33
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Further locations at www.sick.com

Australia

Phone +61 3 9457 0600
1800 334 802 – tollfree

E-Mail sales@sick.com.au

Austria

Phone +43 22 36 62 28 8-0
E-Mail  office@sick.at

Belgium/Luxembourg

Phone  +32 2 466 55 66
E-Mail  info@sick.be

Brazil

Phone +55 11 3215-4900
E-Mail  marketing@sick.com.br

Canada

Phone +1 905 771 14 44
E-Mail  information@sick.com

Czech Republic

Phone +420 2 57 91 18 50
E-Mail  sick@sick.cz

Chile

Phone +56 2 2274 7430
E-Mail info@schadler.com

China

Phone +86 20 2882 3600
E-Mail info.china@sick.net.cn

Denmark

Phone +45 45 82 64 00
E-Mail  sick@sick.dk

Finland

Phone +358-9-2515 800
E-Mail  sick@sick.fi

France

Phone +33 1 64 62 35 00
E-Mail  info@sick.fr

Germany

Phone +49 211 5301-301
E-Mail  info@sick.de

Hong Kong

Phone +852 2153 6300
E-Mail ghk@sick.com.hk

Hungary

Phone +36 1 371 2680
E-Mail  office@sick.hu

India

Phone +91 22 6119 8900
E-Mail info@sick-india.com

Israel

Phone +972 4 6881000
E-Mail  info@sick-sensors.com

Italy

Phone +39 02 274341
E-Mail  info@sick.it

Japan

Phone +81 3 5309 2112
E-Mail  support@sick.jp

Malaysia

Phone +6 03 8080 7425
E-Mail  enquiry.my@sick.com

Mexico

Phone +52 (472) 748 9451
E-Mail mario.garcia@sick.com

Netherlands

Phone +31 30 2044 000
E-Mail  info@sick.nl

New Zealand 

Phone +64 9 415 0459
0800 222 278 – tollfree

E-Mail sales@sick.co.nz

Norway 

Phone +47 67 81 50 00
E-Mail  sick@sick.no

Poland

Phone +48 22 539 41 00
E-Mail  info@sick.pl

Romania

Phone +40 356 171 120 
E-Mail office@sick.ro

Russia

Phone +7 495 775 05 30
E-Mail  info@sick.ru

Singapore

Phone +65 6744 3732
E-Mail  sales.gsg@sick.com

Slovakia

Phone +421 482 901201
E-Mail  mail@sick-sk.sk

Slovenia

Phone +386 591 788 49
E-Mail  office@sick.si

South Africa

Phone +27 11 472 3733
E-Mail info@sickautomation.co.za

South Korea

Phone +82 2 786 6321
E-Mail  info@sickkorea.net

Spain

Phone +34 93 480 31 00
E-Mail  info@sick.es

Sweden

Phone +46 10 110 10 00
E-Mail  info@sick.se

Switzerland

Phone +41 41 619 29 39
E-Mail  contact@sick.ch

Taiwan

Phone +886 2 2375-6288
E-Mail  sales@sick.com.tw

Thailand

Phone +66 2645 0009
E-Mail  Ronnie.Lim@sick.com

Turkey

Phone +90 216 528 50 00
E-Mail  info@sick.com.tr

United Arab Emirates

Phone +971 4 88 65 878
E-Mail  info@sick.ae

United Kingdom

Phone +44 1727 831121
E-Mail  info@sick.co.uk

USA

Phone +1 800 325 7425 
E-Mail  info@sick.com

Vietnam

Phone +84 945452999
E-Mail  Ngo.Duy.Linh@sick.com

80
15

72
8/

11
CF

/2
01

8-
10

 (1
H

KQ
/2

02
2-

12
)


	Inspector PIM60
	Table of Contents
	Part 1. Introduction
	Chapter 1. Overview
	1.1. Safety

	Chapter 2. Applications
	2.1. Verify dimensions and locate position of a known shaped object
	2.2. Measure distance and angle
	2.3. Lid integrity verification

	Chapter 3. Configuration and machine integration
	3.1. Initial configuration
	3.2. Result and image retrieval
	3.3. Configuration and control
	3.4. Connections

	Chapter 4. Toolbox

	Part 2. How To
	Chapter 5. Getting started
	5.1. Preparations
	5.1.1. Open the box
	5.1.2. Install SOPAS
	Install from sick.com


	5.2. Connect
	5.2.1. Connect the hardware
	5.2.2. Connect SOPAS to the Inspector

	5.3. Get a good image
	5.3.1. Calibrate the Inspector (optional)

	5.4. Configure the application
	5.4.1. Teach the reference object
	5.4.2. Apply tools
	5.4.3. Monitor the result
	5.4.4. Using the result


	Chapter 6. Connect
	6.1. Manage IP address
	6.1.1. Troubleshooting connection problems
	No device was found
	Ethernet connector icon is red
	Other connection problems


	6.2. Install a SOPAS Device Driver (SDD)
	6.3. Upgrade or downgrade the firmware
	6.4. Use a simulated device

	Chapter 7. Use SOPAS Engineering Tool (ET)
	7.1. Framework
	7.2. Main view
	7.2.1. Live image tab
	7.2.2. Reference image tab
	7.2.3. Logged images tab

	7.3. InspectorPIM60 menu
	7.4. Configuration workflow

	Chapter 8. Adjust image
	8.1. Adjust focus
	8.2. Adjust image settings
	8.2.1. Adjust exposure
	8.2.2. Adjust gain

	8.3. Use lighting
	8.3.1. Use internal lighting
	8.3.2. Use external lighting

	8.4. Adjust image size/field of view

	Chapter 9. Calibrate and align
	9.1. Overview
	9.1.1. Calibration target

	9.2. Calibrate
	9.3. Align to external coordinates

	Chapter 10. Use the toolbox
	10.1. General
	10.1.1. Add positioning and inspection tools
	10.1.2. Add measurement tools
	10.1.3. Common tool settings
	10.1.4. Search direction of edge based tools

	10.2. Object locator
	10.2.1. Setting
	10.2.2. Results

	10.3. Circle
	10.3.1. Settings
	10.3.2. Results and tolerances

	10.4. Edge tools (Edge)
	10.4.1. Settings
	10.4.2. Results and tolerances

	10.5. Edge tools (Find maximum)
	10.5.1. Settings
	10.5.2. Results and tolerances

	10.6. Edge counter
	10.6.1. Settings
	10.6.2. Results and tolerances

	10.7. Blob
	10.7.1. Settings
	10.7.2. Results
	10.7.3. Use blob angle
	10.7.4. Use blob structure criteria
	10.7.5. Number of blobs

	10.8. Pattern
	10.8.1. Settings
	10.8.2. Results

	10.9. Polygon (not included in PIM60 Bead P/N 1076617, 1079321, 1079322)
	10.9.1. Adding a polygon
	10.9.2. Algorithm
	10.9.3. Algorithm - Single edge tool
	10.9.4. Parameters
	10.9.5. Defect detection

	10.10. Bead tool (only included in PIM60 Bead P/N 1076617, 1079321, 1079322)
	10.10.1. Adding a bead tool
	10.10.2. Settings
	10.10.3. Results and tolerances
	10.10.4. Improve speed

	10.11. Pixel counter
	10.11.1. Settings
	10.11.2. Results

	10.12. Edge pixel counter
	10.12.1. Settings
	10.12.2. Results

	10.13. Distance
	10.13.1. Settings
	10.13.2. Results and tolerances

	10.14. Angle
	10.14.1. Settings
	10.14.2. Result and tolerances


	Chapter 11. View result and statistics
	11.1. Results
	11.2. Statistics

	Chapter 12. Work with multiple objects
	12.1. Teach additional objects
	12.2. Select reference object
	12.2.1. Select object using SOPAS
	12.2.2. Select reference object with interfaces and I/O

	12.3. Duplicate reference objects
	12.4. Settings for multiple reference objects

	Chapter 13. Interfaces
	13.1. Overview interfaces
	13.2. Simultaneous use and restrictions of the interfaces

	Chapter 14. Use digital I/O
	14.1. Overview digital I/O
	14.2. Use digital inputs
	14.2.1. Use external teach
	14.2.2. Connect an external image trigger
	14.2.3. Connect an encoder
	14.2.4. Select reference objects with inputs

	14.3. Use digital outputs
	14.3.1. Digital output settings tab
	List of outputs
	Assign logical expressions to outputs

	14.3.2. Digital output expression editor
	14.3.3. Set output delay
	14.3.4. Set output active time
	14.3.5. Invert output signals
	14.3.6. Connect an external light

	14.4. Set up the connection I/O extension box

	Chapter 15. Use EtherNet/IP
	15.1. Set up the connection EtherNet/IP
	15.2. Output results
	15.3. Control the sensor via EtherNet/IP

	Chapter 16. Use Ethernet Raw
	16.1. Set up the connection Ethernet Raw
	16.2. Output results
	16.3. Control the sensor via Ethernet Raw
	16.3.1. Set up the connection Ethernet Raw command channel

	16.4. Communicate with Simatic S7 controls

	Chapter 17. Use web interface
	17.1. Set up connection to the web server
	17.2. Default web page
	17.2.1. Backup and restore configuration
	17.2.2. Upload and remove custom web pages

	17.3. Creating custom web pages
	17.4. Web API

	Chapter 18. Store images on an FTP server
	Chapter 19. Improve image quality
	19.1. Change lens
	19.2. Improve reflex avoidance
	19.2.1. Dome
	19.2.2. Tilt device

	19.3. Calibrate image
	19.4. Optimize contrast on multi colored targets
	19.4.1. Mounting filters

	19.5. Environmental conditions

	Chapter 20. Improve robustness
	20.1. Object locator
	20.2. Circle
	20.3. Edge
	20.4. Edge counter
	20.5. Blob
	20.5.1. Enable Ambient light compensation

	20.6. Polygon
	20.7. Pattern, Pixel counter, Edge pixel counter
	20.8. Replace reference image

	Chapter 21. Improve speed
	Chapter 22. Log and store images
	22.1. Use image log
	22.2. Store images on a FTP server
	22.3. Record live images to PC

	Chapter 23. Use the simulated device
	23.1. Start the simulated device
	23.1.1. When connected to an Inspector
	23.1.2. From SOPAS Engineering Tool (ET)

	23.2. Control the simulated device
	23.3. Select images to be used
	23.4. Copy device data from the simulated device to an Inspector

	Chapter 24. Handle device data
	24.1. Save device data on the Inspector (in flash memory)
	24.2. Save device data on PC
	24.3. Use saved device data on the Inspector
	24.4. Copying device data from one Inspector to another
	24.5. Export and import device data through web server or Web API
	24.6. Restore settings to factory default


	Part 3. Appendix
	Appendix A. Technical data
	A.1. Dimensional drawings
	A.2. Inspector connectors
	A.3. LED description
	A.4. Technical specification
	A.5. Accessories ordering information
	A.6. What's included – Inspector PIM60
	A.7. System requirements

	Appendix B. Support
	B.1. Technical support
	B.1.1. Preparing for technical support
	B.1.2. Web support
	B.1.3. First line support

	B.2. Further information


	Glossary
	Index



